
INMARSAT MINI-C MES

FELCOM19

OPERATOR'S MANUAL

www.furuno.com

MODEL



*00017651410**00017651410*
*00017651410**00017651410*



i

IMPORTANT NOTICES

General

How to discard this product

Discard this product according to local regulations for the disposal of industrial waste. For disposal 

in the USA, see the homepage of the Electronics Industries Alliance (http://www.eiae.org/) for the 

correct method of disposal.

How to discard a used battery

Some FURUNO products have a battery(ies). To see if your product has a battery, see the chapter 

on Maintenance. Follow the instructions below if a battery is used. Tape the + and - terminals of 

battery before disposal to prevent fire, heat generation caused by short circuit.

In the European Union

The crossed-out trash can symbol indicates that all types of batteries 

must not be discarded in standard trash, or at a trash site. Take the 

used batteries to a battery collection site according to your national 

legislation and the Batteries Directive 2006/66/EU.

In the USA

The Mobius loop symbol (three chasing arrows) indicates that Ni-Cd 

and lead-acid rechargeable batteries must be recycled. Take the used 

batteries to a battery collection site according to local laws.

In the other countries

There are no international standards for the battery recycle symbol. The number of symbols can 

increase when the other countries make their own recycle symbols in the future.

• This manual has been authored with simplified grammar, to meet the needs of international users.

• The operator of this equipment must read and follow the descriptions in this manual. Wrong oper-

ation or maintenance can cancel the warranty or cause injury.

• Do not copy any part of this manual without written permission from FURUNO.

• If this manual is lost or worn, contact your dealer about replacement.

• The contents of this manual and equipment specifications can change without notice.

• The example screens (or illustrations) shown in this manual can be different from the screens you 

see on your display. The screens you see depend on your system configuration and equipment 

settings.

• Save this manual for future reference.

• Any modification of the equipment (including software) by persons not authorized by FURUNO will 

cancel the warranty.

• All brand and product names are trademarks, registered trademarks or service marks of their re-

spective holders.

• Microsoft, Windows and Windows Vista are registered trademarks or trademarks of the Microsoft 

Corporation in the United States and other countries.

Cd

Ni-Cd Pb
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SAFETY INSTRUCTIONS

WARNING

WARNING
Do not open the equipment.

The equipment uses high voltage that 
can cause electrical shock. Refer any 
repair work to a qualified technician.

Do not approach the antenna unit 
closer than the distance shown 
below when transmitting.

The radome emits radio waves that can 
be harmful, particularly the eyes.

If water leaks into the equipment or 
something is dropped into the 
equipment, immediately turn off the 
power at the switchboard.

Fire or electrical shock can result.

If the equipment is giving off smoke 
or fire, immediately turn off the 
power at the switchboard.

Fire or electrical shock can result.

WARNING
If you feel the equipment is acting 
abnormally or giving off strange 
noises, immediately turn off the 
power at the switchboard and 
contact a FURUNO service techni-
cian.

Do not disassemble or modify the 
equipment.

Fire, electrical shock or serious injury 
can result.

Make sure no rain or water splash 
leaks into the equipment protected 
from the weather.

Fire or electrical shock can result if 
water leaks into the equipment.

Do not place liquid-filled containers 
on or near the equipment.

Fire or electrical shock can result if a 
liquid spills into the equipment.

Do not operate the equipment with 
wet hands.

Electrical shock can result.

Use the proper fuse. 

Use of the wrong fuse can cause fire or 
electrical shock.

The operator must read the safety instructions before attempting to operate the equipment.

WARNING Indicates a potentially hazardous situation which, if not avoided, 

could result in death or serious injury.

CAUTION
Indicates a potentially hazardous situation which, if not avoided, 

could result in minor or moderate injury.

Warning, Caution Prohibitive Action Mandatory Action

Radiation Level At
10W/m2 0.5 m
100W/m2 0.1 m
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Warning labels are attached to the communication unit. Do not remove the labels. If a 
label is missing or damaged, contact a FURUNO agent or dealer about replacement.

Warning Label

Name: Warning Label (1) 
Type: 86-003-1011-3
Code No.: 100-236-233-10

WARNING
To avoid electrical shock,
do not remove cover.
No user-serviceable parts
inside.

Name: Warning Label (2) 
Type: 03-129-1001-3
Code No.: 100-236-743-10

WARNING
To avoid electrical shock, do not 
remove cover. No user-serviceable 
parts inside.
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FOREWORD

A Word to FELCOM19 Owners

Congratulations on your choice of the FURUNO FELCOM19 Inmarsat Mini-C MES. We are con-

fident you will see why the FURUNO name has become synonymous with quality and reliability.

Since 1948, FURUNO Electric Company has enjoyed an enviable reputation for innovative and 

dependable marine electronics equipment. This dedication to excellence is furthered by our ex-

tensive global network of agents and dealers.

This equipment is designed and constructed to meet the rigorous demands of the marine environ-

ment. However, no machine can perform its intended function unless operated and maintained 

properly. Please carefully read and follow the recommended procedures for operation and main-

tenance.

We would appreciate hearing from you, the end user, about whether we are achieving our purpos-

es.

Thank you for considering and purchasing FURUNO equipment.

Features

The FELCOM19 mainly consists of an antenna unit and a communication unit. Connected to a 

PC, the FELCOM19 provides the full range of general communication services for mobile and 

fixed terrestrial subscribers in the Inmarsat C communication network. Its compact size permits 

installation where space is limited. 

The main features are

• Complies with Conforms to the following standards: IMO A.807(19), MSC.68(68) Annex 4, 

MSC/Circ 862, IMO A.694(17), IEC 60945-4, IMO A.664(16), IEC 61162-1.

• E-mail facility. (To transmit E-mail, register with an LES provider which provides e-mail services. 

E-mail charges are calculated separately.)

• Built-in Enhanced Group Call (EGC) receiver. System may be set to operate as EGC-only re-

ceiver. 

• Data reporting and polling 

• Store-and-forward telex communication (public telex network)

• Diagnostic programs for maintenance 

• Menu driven operation

• EPADR (Enhanced Pre-Assigned Data Reporting) applicable.

• VMS (Vessel Monitoring System) applicable.
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Program No.

About Inmarsat-C

This manual provides a brief introduction to the Inmarsat C system, in Chapter 1. For further in-

formation, see the Inmarsat home page at www.inmarsat.com.

Unit Program no. Date of modification

COMMUNICATION 

UNIT

1650248-xx

PC TERMINAL 1650241-xx
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SYSTEM CONFIGURATION

ANTENNA

UNIT

IC-119

PERSONAL

COMPUTER 

(Windows OS)
COMMUNICATION UNIT IC-219

(with internal GPS receiver)

100-115/200-230 VAC

1φ, 50/60 Hz

: Standard supply

: Optional or

  Local Supply

12/24 VDC

AC-DC

Power Supply

PR-240

JUNCTION BOX

IC-318

SSAS ALERT UNIT

IC-307*

SSAS ALERT UNIT

IC-307*

CATEGORY OF UNITS:

Unit                           Category

Communication Unit     Protected from the weather               

Antenna Unit            Exposed to the weather               

Other Units            Protected from the weather               

* At least two SSAS Alert Units 

are required.

NAVIGATOR

(GNSS

compliant)

24 VDC
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1. INMARSAT C SYSTEM
OVERVIEW

1.1 Introduction

The Inmarsat C system provides worldwide telex and data transmission and reception 

of written information to owners of an Inmarsat C transceiver or a terrestrial telex net-

work via satellite. Further, e-mail can be sent via the internet. 

Communication mode is store-and-forward telex, which means all information sent are 

first stored at an LES (Land Earth Station) and then delivered to designated party. 

An EGC (Enhanced Group Call) receiver is built in the FELCOM system to receive the 

following types of messages, broadcast by LESs:

• SafetyNET: Governments and maritime authorities can use this service to distribute 

maritime safety information to ships within selected areas.

• FleetNET: Commercial subscription organizations or shipping companies can use 

this service to transmit trade information (for example, company news or market 

prices) simultaneously to a selected group of ships, to provide up-to-the-minute in-

formation. 

• EGC system-related messages are sent by Inmarsat to certain shipping companies 

and geographical areas.

Besides its primary application of ship-shore, shore-ship or ship-ship communications, 

the Inmarsat C service has also proved beneficial to trucking firms who have found it 

indispensable for communicating with their vehicles. This manual, however, concen-

trates on the ship applications, the main application.
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Inmarsat-C system configuration

The Inmarsat C system consists of the Operation Control Center (OCC), Satellite Con-

trol Centers (SCC), Network Coordination Stations (NCS), Land Earth Stations (LES) 

and Mobile Earth Stations (MES). The OCC, located at Inmarsat’s London headquar-

ters, coordinates a wide range of activities in the Inmarsat system, including commis-

sioning of mobile earth stations. 

The Inmarsat C system divides the world into four regions and each region is covered 

by its own satellite.

Inmarsat system satellites

In each region there is one NCS and several LESs. The NCS keeps track of all Inmar-

sat C transceivers in its region and broadcasts information such as navigational warn-

ings, weather reports and news. The LESs provide the link between the MES and the 

terrestrial telecommunications networks via satellite.

Region Satellite Satellite position

AOR-West Inmarsat 3, F4 54.0°W

AOR-East Inmarsat 3, F2 15.5°W

IOR Inmarsat 3, F1 64.0°E

POR Inmarsat 3, F3  178.0°E

Satellite

AOR-West                             AOR-East                 IOR                    POR

Same as left        Same as left      Same as left

0.0  m

-/+: To set option

0.0  m

-/+: To set option

0.0  m

-/+: To set option

MES

OCC: Operation Control Center

SCC: Satellite Control Center

NCS: Network Coordination Station

MES: Mobile Earth Station

LES: Land Earth Station

LES LES LES

NCS

SCC

OCC
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Inmarsat-C satellite coverage area

1.2 Communications Network

The illustration below shows the Inmarsat C communications network.

Telex Network

Terrestrial

Communications

Network

Land Earth

Station

(LES)

MES Signaling

Channel

MES Message

Channel

LES TDM

Channel

NCS/LES

Signaling Link

Network

Coordination

Station (NCS)

NCS/NCS Signaling Link

NCS Common Channel

Mobile Earth

Station (MES)

Data Terminal

Equipment (DTE)

Enhanced Group

Calling (EGC) Receiver

Data Circuit

Terminating

Equipment

(DCE)

Data

Communications

Network
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Types of MES

There are three types of MES: class 1, class 2 and class 3. This FELCOM is a class 

2 MES.

Section Description

NCS common channel The NCS has two major functions: 
• Transmit information on a common channel.
• Transmit EGC messages to MESs.

NCS/LES signaling link The NCS/LES signaling link connects the NCS to all 
LESs in its region. All EGC messages pass through 
this link.

LES TDM channel The LES TDM channel carries the circuit control sig-
nal for MES and transmits messages from LES to 
MES. 

MES message channel The MES message channel carries messages from 
MES to LES.

MES signaling channel The MES signaling channel transmits requests, data 
reports, etc. This channel also carries login and logout 
from MES to NCS. 

NCS/NCS signaling link This NCS/NCS signaling link connects all NCSs. This 
link exchanges data between NCSs operating in dif-
ferent ocean regions.

MES interface The MES consists of the Data Circuit Terminating 
Equipment (DCE) and the Data Terminal Equipment 
(DTE). The DCE consists of the antenna unit, and the 
DTE consists of a communication unit, terminal unit 
(PC) and printer. 

Terrestrial network interface The major functions of the LESs are: 
• Telex store-and-forward conversion
• Handling EGC messages
• Data reporting and polling

Class 1: • Transmits messages to LES.
• Receives messages from LES.

Class 2: • The functions of class 1 plus operation as an EGC receiver when not 
transmitting or receiving.

• EGC-only receiver

Class 3: The function of class 1 plus simultaneous operation as an EGC-only receiv-
er.
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2. OPERATIONAL OVERVIEW

2.1 Communication Unit

The communication unit is the heart of the FELCOM system, transmitting and receiv-

ing messages via the Inmarsat system.

2.1.1 How to turn the power on and off

Press the POWER switch to power the communication unit and antenna unit on or off. 

2.1.2 Diagnostics

When the communication unit is turned on it automatically conducts a series of diag-

nostic tests to check itself for proper operation. The test takes about 30 seconds and 

the LEDs flash one by one, in the order of left to right. For further details, see Chapter 

8.

2.2 Terminal Unit (PC) Operation

All operations are carried out from the terminal unit (local supply), through an easy-to-

follow menu system. In this manual the PC is referred to as “Terminal Unit.” Note that 

it is necessary to supply a printer. 

PC requirements

• Operating system: Windows XP®, Windows Vista®, Windows 7®

• RAM: At least 512 MB (at least 1GB is recommended)

• Hard disk: At least 1 GB free space

• CPU: 1 GHz processor or faster

• CD-ROM drive

POWER

Switch

Status LEDs

POWER: Lights (in green) when power is on.

LOGIN: Lights (in green) when logged in;

 flashes (in green) in other instances.

TX: Lights (in green) when transmitting.

ERROR: Flashes (in red) for equipment error.
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2.2.1 How to install the software

1. Turn on the PC.

2. Set the installation CD-ROM in the CD drive of the PC.

3. Click the icon of SETUP. EXE.

4. Click the [Next] button. Enter user and organization. Click the applicable radio but-

ton at the bottom of the screen.

5. Click the [Next] button.

6. Click the [Next] button.
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7. Click the [Next] button to start the installation. When the installation is completed, 

the FELCOM dialog box appears.

8. Click the [Close] button at the top right corner of the dialog box. The [Setup Com-

plete] dialog box appears. 

Note:  If you want to launch the program now, click the box next to "Yes, launch 

the program file." The application launches after the completion of step 9.

9. Click the [Finish] button. The FELCOM application shortcut is created on the desk-

top of the PC.
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2.2.2 Starting, quitting the application

For information about terminal unit operation see the PC’s owner’s manual. 

1. Turn on the communication unit.

2. Turn on the terminal unit.

3. Double-click the F19PC icon to start the application. After the program 

loads the standby display appears.

4. To quit the application, press the F12 key while pressing the Alt key. The 

following confirmation window appears. (You may also quit the application by 

clicking the Close button at the top right corner of the screen.)

5. [Yes] is selected; press the Enter key.

6. Turn off the terminal unit in accordance with Windows® operating procedure.

7. Turn off the communication unit.

Note: If a different method is used to quit the application, any settings changed before 

quitting will not be saved.

2.2.3 Key description

Key Function

Esc • Cancels key input and returns to previous display screen.
• Long push to return to the standby display.

F1 - F10 Select menus. See section 2.2.5.

BackSpace Deletes the character to the left of the cursor.

Insert Works the same as “paste.” See “How to cut and paste text” in 
section 4.2.4.

Delete Deletes the character selected with the cursor.

Home Moves the cursor to the top of the message being edited. 

End Moves the cursor to the bottom of the message being edited. 

Page Up Goes to the previous page of the edit screen.

Page Down Goes to the next page of the edit screen. 

↑, ↓, ←, → Control the cursor.

Enter Registers key input; inserts carriage return in TX message. 

Shift Chooses upper or lower case alphabet. Press and hold down the key 
and then press the [Caps Lock] key to get upper or lower case alpha-
bet. Note that only upper case alphabet are used in telex.

Alt Provides the shortcut key operation when combined with an alphabet 
key. See section 2.2.4.

Spacebar Inserts a space. In addition, it displays the file list, a partial view of a 
file, etc., depending on the menu. 

NoYes

OK to quit system?
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Note: In telex, lower case, #, &, *, $, @, %, etc. are not permitted. A full list of charac-

ters usable in telex appears in the Appendix. For e-mail all characters and symbols 

may be used.

2.2.4 Shortcut keys

The FELCOM provides the keyboard shortcuts shown below for commonly used func-

tions.

Caps Lock Turns upper case alphabet input on or off. The Caps Lock LED lights 
when upper case alphabet input is on.

Tab Inserts horizontal tab characters. The number of tab characters the 
key can insert per line of text can be programmed for two, four or eight 
tabs. 

Ctrl Works in combination with alphabet keys as follows:
• Ctrl + [M]: Same as Enter.
• Ctrl + [H]: Same as Back Space.
• Ctrl + [I]: Same as Insert.
• Ctrl + [V]: Same as Overwrite+Insert on Edit Mode in the Editor Set-

up menu.

Num Lock Turns numeric input on or off.

Shortcut key Function

Alt+N Same as [New] in [File] menu.

Alt+O Same as [Open] in [File] menu.

Alt+Q Same as [Close] in [File] menu.

Alt+S Save as [Save] in [File] menu.

Alt+P Save as [Print] in [File] menu.

Alt+X Same as [Undo] in [Edit] menu; undo last [Cut], [Paste].

Delete Same as [Cut] in [Edit] menu.

Alt+C Same as [Copy] in [Edit] menu.

Insert Same as [Paste] in [Edit] menu.

Alt+V Same as [Change Window] in [Edit] menu.

Key Function
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2.2.5 Function keys

The function keys are labeled F1-F10 on the keyboard and they provide the following 

functions.

Menu (key) Function

File (F1) Opes and closes file; print files; MIME decoding.

Edit (F2) Text editing facilities (copy, paste, search and replace, etc.).

Transmit (F3) Transmit messages; request delivery status.

EGC (F4) Display EGC messages; show EGC network ID.

Reports (F5) Facilities for data reporting, message reporting, and EPADR.

Logs (F6) Display logs for sent and received messages, EGC messages; 
show the communications log.

Options (F7) Facilities for login and logout, manual position input, testing, 
maintenance, NCS and ocean region selection.

Setup (F8) Menus for system setup, editor setup, EGC setup, auto mode set-
up, e-mail setup, and configuration.

(F9) No use

StopAlarm (F10) Silence audio alarm.

Esc F1 F2 F3 F4 F5 F6 F7 F8 F9 F10

File

Edit

Transmit

EGC

Reports

Logs
Options

Setup StopAlarm

No use
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2.3 Standby Display

After the equipment is turned on and the diagnostic test is completed, the standby dis-

play appears, showing the results of the test. The system status monitor provides var-

ious operating information. For further information, see section 8.4.

After the diagnostic test is completed, the equipment automatically starts synchroniz-

ing itself with a satellite. When the indication "Retuning" is replaced with

"SYNC(NCS)", the synchronization process is completed. Then, you are ready to re-

ceive EGC messages. See section 3.4.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup                    StopAlarm

Date

Time

Position

Waypoint

Course 345.5 DEG 

Speed   10.2 kn

Current NCS

Current Channel

Current TDM

MES Status

GPS Status

DCE Memory

Jan-12-12

01:32 (UTC)

LAT   34:30.00N

LON 135:00.00E

LAT

LON

344 (IOR)   LOGOUT

NCS CC

NCS CC

Idle

****

32818 Bytes free

                                  IMN:

BBER

C/N

Send Level

Rx AGC Level

REF Offset Freq

Synthe Local             

TCXO Control                   131          

Antenna Power Supply

Water Temperature

Water Current

Direction

Speed

Depth

443156710

000

OK (    0 dB)

OK (    0)

OK (254)

OK (       0 Hz)

OK

OK

Current State: IDLE

DCE F19 Ver. xx

Retuning

NCS: IOR        LOGOUT              LAT:   34:30.00N

REC. MESSAGE EXISTS             LON: 135:00.00E

Jan-12-12  01:32 (UTC)

68.2 DEG

232  DEG

1.9   kn

xx: Program Version No. of COMMCPU Board
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2.3.1 Display indications

The display is divided in three areas:

1) The function menu area

2) The working area

3) The operating status area 

(1) Communications network mode

No display: Normal operation.

Restoration mode (reverse video): Previously designated LES is transmitting the 

NCS common channel signal.

(2) Communication unit status

IDLE: Idle (awaiting receiving, awaiting transmitting).

IDLE (PENDING): Awaiting reply from LES.

SENDING: Sending.

RECEIVING: Receiving.

LOGIN: Logging in with NCS.

LOGOUT: Logging out with NCS.

Data Report: Sending data report.

TESTING: Performance Verification (PV) testing.

TEST SETUP: Requesting PV testing.

SCANNING: NCS scanning.

EGC RECEIVER (Reverse video): EGC-only receiver operation.

DELIVER STATUS REQ.: Transmitting delivery status request.

FORCED CLEARING: Stopping receiving, transmitting, or scanning.

3(a) Communication status

CALLING: Now calling.

WAITING FOR ACKNOWLEDGEMENT: Waiting for acknowledgement from LES.

RECEIVING EGC MESSAGE: Now receiving EGC message.

WAITING FOR BACKOFF: Waiting to transmit data report.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup                    StopAlarm

                                                                   (2)

(2)
(3a)
(3b)

(4)
(5)                      (6)
(7)

(8)
         (9)
         (9)

2) WORKING AREA

1) Function

Menu

3) Operating

Status

(1)
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Successful Login.: Login was successful.

Login failed.: Login failed.

Successful Logout: Logout was successful.

Logout failed.: Logout failed.

Successful Forced Clearing.: Forced clearing successful.

Forced Clearing Failed.: Forced clearing unsuccessful.

SENDING MESSAGE PACKETS: Sending TX message packets.

WAITING FOR ACKNOWLEDGEMENT: Waiting for acknowledgement from LES.

Successful sending to LES.: Message successfully sent to LES.

Sending message failed.: Message could not be sent to LES.

Call rejected.: LES rejected your message.

Call pending.: LES temporarily suspending communications.

Received Call.: Call received from LES.

Received Call(ITA2).: Call(ITA2) received from LES.

RECEIVING MESSAGE PACKETS: Receiving message packets.

CLEARING: Clearing TX sequence.

Successful receiving.: You successfully received message.

Receiving failed.: You could not receive message.

Successful Data Report.: Data report successfully sent.

Data Report failure.: Data report could not be sent.

PV TEST CALL is rejected.: PV test call rejected by NCS.

PV TEST CALL is pending.: PV test call pending by LES.

TEST-RECEIVING MESSAGE: Receiving test message from LES.

TEST-SENDING MESSAGE: Sending test message to LES.

WAITING FOR ACTIVATION: Waiting start of PV test.

WAITING FOR TEST RESULT: Waiting for results of PV test.

CLEARING: Clearing PV test.

PV TEST is Completed.: PV test is completed.

PV TEST Failure.: PV test failed.

(3b) COMMCPU program version number

DCE F19 Ver. XX: (XX = Version Number).

Trouble messages also appear here. See section 8.7.1.

(4) Frame synchronization

Blank: Changing channel, or during transmission.

SYNC (NCS): Synchronizing with NCS.

SYNC (LES): Synchronizing with LES.

MES Sig. Ch: Changing MES signaling channel.

MES Msg. Ch: Changing MES message channel.

UNSYNC: Out of synchronization.

Retuning: Synchronizing with NCS or LES.

(5) Ocean region currently being received

No display: Out of synch with satellite.

AOR-W: Atlantic Ocean Region-West.

AOR-E: Atlantic Ocean Region-East.

IOR: Indian Ocean Region.

POR: Pacific Ocean Region.



2.  OPERATIONAL OVERVIEW

2-10

(6) Logging status

LOGOUT: Logged out with ocean region.

LOGIN: Logged in with ocean region.

LOGIN (flashing): Logging in with ocean region.

(7) Other information

Various messages appear at this location.

No display: No receive message in memory, or printer is operating.

REC. MESSAGE EXISTS (reverse video): Displayed when a routine message has not 

been printed, or a confidential message is received.

Data Report: When data reporting is activated.

Message Report (reverse video): Message report setting is activated.

(8) Date and time display

Date and time, received from the GPS navigator, are displayed. Manually input date 

and time are also displayed.

(9) Position

Ship’s position, received from the GPS navigator, is displayed in latitude and longi-

tude, or manually input position is displayed.

2.4 Menu Overview

Operation of the FELCOM is done through a menu system which you access with the 

function keys on the terminal unit. The example below shows how to select menu op-

tions from the [Editor Setup] menu.

1. Press the F8 key to display the [Setup] menu.

2. Choose a desired menu by pressing appropriate numeric key. For example, press 

the 2 key to show the [Editor Setup] menu. (You can also select a menu with the 

↑ and ↓ keys. Press the Enter key after making a selection.)

3. Choose a desired menu item by pressing the ↑ or ↓ key followed by the 

Enter key. A window displaying the options for the item selected or an 

Setup

1. System Setup

2. Editor Setup

3. Terminal Setup

4. EGC Setup

5. Auto Mode Setup

6. E-Mail Setup

7. Directories

8. Configuration

2. System Setup

3. Editor Setup

4. Terminal Setup

5. EGC Setup

6. Auto Mode Setup

7. E-Mail Setup

8. Directories

9. Configuration

Editor Setup

Ascii

Insert

ON

ON

4 Char

69

Block

Full Screen

Text Mode 

Edit Mode

Word Wrap

Line No. 

Tab Width 

Column Width

Cursor Type

Scroll

ON

OFF
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alphanumeric data entry window appears depending on your selection. For exam-

ple, the window at right shows the options for [Word Wrap].

4. Press the ↑ or ↓ key to select an option desired and press the Enter key.

5. Long-press the Esc key to return to the standby display.

Note 1: On some menus the [Update] window appears after you press 

the Enter key. This is done to ask you to confirm settings. [Yes] is se-

lected; press the Enter key to register settings, or press [→] to select 

[No] and press the Enter key to escape. If invalid data is entered, an ap-

plicable error message appears and the previous setting is restored. 

Note 2: The following functions are not available:

Note 3: In the [System Setup] menu, the message "Wait..." appears while a process 

is being executed. The message disappears when the process is completed.

Note 4: To return to the standby display at any time (except the message preparation 

screen), long-press the Esc key.

2.5 Error Messages and Alerts

The terminal unit displays error messages and alerts, in the CAUTION window, to call 

your attention to mis-operation, failed operation and system error. A list of error mes-

sages appears in section 8.7 and alerts appear in the Appendix 2.

To erase an error message or alert, press the Esc key. 

Keying sequence Item

F3-1
F8-1

F8-4

Selection of priority on transmit message
[NAV PORT], [LAN PORT], [MESSAGE OUTPUT PORT], 
[EGC OUTPUT PORT], [NETWORK SETUP] (parts of) on 
[System Setup] menu 
Waypoint on [EGC Setup] menu

Update

Yes No

Wait...

No.   Message File    Destination          LES        Priority Send Status           Delivery

Sent Message

CAUTION
No Message.

<Press ESC key to continue>
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2.6 How to Select a Printer

1. Press the F1 key to open the [File] menu.

2. Press the 8 key to open the [Print Setting] window.

3. Select appropriate printer.

No Printer: Select if no printer is connected. to the PC.

Windows® Printer: Select if PC printer is connected to the PC.

PP-501: Select if the PP-510 is connected to the PC.

4. Press the Enter key to finish.

File

ALT-N

ALT-O

ALT-Q

ALT-S

ALT-D

ALT-P

1. New

2. Open

3. Close

4. Save

5. Delete

6. Rename

7. Print

8. Print Setting

9. MIME (Decode)

No Printer

Windows Printer

PP-510

Please select Printer

and press Enter key.

Print Setting
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3. SYSTEM INITIALIZATION

This chapter provides the information necessary for initializing the FELCOM19. Once 

the equipment is initialized, you need do no more than press a few keys to get fully 

automatic transmission and reception.

Inmarsat assigns an MES (your ship) an Inmarsat Mobile Number (IMN) when it ap-

plies for Inmarsat registration and it is entered during the installation of the MES. The 

IMN is necessary to communicate in the Inmarsat system.

3.1 System Settings

3.1.1 Confirm the main terminal

The main terminal is where you set up the system. (You cannot set up the system from 

an external terminal.) Confirm that the main terminal is selected as below.

1. Press the F8 key to show the [Setup] menu.

If your screen looks something like the one shown in the illustration above, you are 

using the main terminal. (If you are using an external terminal, some menu items ap-

pear in gray.)

3.1.2 System setup

The [System Setup] menu is where you enter the date, time, operating mode, and port 

function.

1. Press the F8 and 1 keys to show the [System Setup] menu.

2. [System Date & Time] is selected; press the Enter key to open the date entry win-

dow.

3. Enter the date with the numeric keys.

4. Press the Enter key to close the window. (Note that the IMN is entered during in-

stallation. The IMN window cannot be opened.)

Setup

1. System Setup

2. Editor Setup

3. Terminal Setup

4. EGC Setup

5. Auto Mode Setup

6. E-Mail Setup

7. Directories

8. Configuration

System Setup

03:11 11-12-25 (YY-MM-DD)

123456789

INMARSAT-C

EXT

ON

INT

INT

System Date & Time

IMN

MES Operation Mode

Nav Port

LAN Port

Message Output Port

EGC Output Port

Network Setup

Command Window

Entered at installation

(Cannot be changed.)

For the serviceman
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5. Select [MES Operation Mode] then press the Enter key to show the MES Opera-

tion window.

6. Select an operating mode, [INMARSAT-C] or [EGC]. The INMARSAT-C setting 

provides telex communications and operates as an EGC receiver when the equip-

ment is not transmitting or receiving. The EGC setting enables EGC-only opera-

tion. In this case, "Current State: EGC RECEIVER" appears (reverse video) at the 

bottom of the screen.

7. Press the Enter key to close the window.

8. Press the Esc key to show the [Update] window.

9. [Yes] is selected; press the Enter key to update the system settings.

10. Long-press the Esc key to return to the standby display.

3.2 PC Window Setup

The [Terminal Setup] menu provides for set up of the PC window. The set up includes 

selection of date display format, currency unit and window colors.

1. Press the F8 and 3 keys to show the [Terminal Setup] menu.

2. Select [Connection] then press the Enter key to show the [Connection List]. This 

list shows the names of the terminals that can be connected to the LAN interface.

Note: The No. Name, IMN, IP address/subnet mask and software version of each 

terminal are shown. The asterisk marks the terminal currently selected for

communication.

3. Select the terminal to use then press the Enter key.

4. Select [Date Disp. Form] then press the Enter key to open its options window.

5. Select [YY-MM-DD], [MMM-DD-YY] or [DD-MMM-YY] as appropriate then press 

the Enter key.

6. Select [Screen Saver] then press the Enter key.

7. Turn the screensaver ON or OFF as appropriate then press the Enter key. When 

enabled, the screensaver automatically starts 10 minutes after there is no key op-

eration. To release the screensaver, press any key.

Connection

Date Disp. Form YY-MM-DD

Screen Saver OFF

Window Color

Terminal Setup 

No. Name IMN IP Address Software Version

*01 F19_123456 123432588 172.31.16.100/24 1650248-01

 02 F19_133234 456789210 192.168.16.11/24 1650248-01

 03

 04

 05

 06

 07

 08

 09

 10

Connection List 
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8. Select [Window Color] then press the Enter key.

9. Set the window colors as follows:

1) [Select Preset] provides three preconfigured window color sets. Use one of 

these sets, or continue this procedure to customize window colors.

2) Select [Window]. Use ← or → key to select the window for which to select col-

or.

Base Window: Standby display

RCV Message Display: Receive message display

EGC Message Display: EGC message display

EDIT1 - EDIT2: Editor screens 1 and 2

Function: Menu

Sub Menu 1 - Sub Menu 4: Sub menus 1-4

Message: Status message

Preset

No.
Window Fore Color Back Color

1 Base Window L-WHITE BLUE

RCV Message Display WHITE BLACK

EGC Message Display WHITE BLACK

EDIT 1 BLACK GREEN

EDIT 2 MAGENTA WHITE

Function BLACK CYAN

Sub Menu 1 BLACK WHITE

Sub Menu 2 BLUE WHITE

Sub Menu 3 L-WHITE BLACK

Sub Menu 4 WHITE BLACK

Message WHITE MAGENTA

Window Color 

Select Preset 1      2      3

Load Default

 

- - - - - - - - - - - - - - - - - - - - - - -
Edit Color

Window [  Base Window  ]

Fore Color [  L-WHITE                      ]

Back Color [  BLUE   ]

- - - - - - - - - - - - - - - - - - - - - - -
To Change: ENTER    To Change Value:L<=>R
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2 Base Window BLACK L-WHITE

RCV Message Display BLACK WHITE

EGC Message Display BLACK WHITE

EDIT 1 BLACK WHITE

EDIT 2 BLACK L-CYAN

Function BLACK WHITE

Sub Menu 1 BLUE L-WHITE

Sub Menu 2 BLUE WHITE

Sub Menu 3 L-WHITE BLUE

Sub Menu 4 WHITE BLACK

Message L-WHITE BLUE

3 Base Window L-WHITE BLACK

RCV Message Display BLACK GRAY

EGC Message Display BLACK GRAY

EDIT 1 BLACK GRAY

EDIT 2 WHITE BLUE

Function L-WHITE BLACK

Sub Menu 1 L-CYAN BLACK

Sub Menu 2 L-GREEN BLACK

Sub Menu 3 L-MAGENTA BLACK

Sub Menu 4 WHITE BLACK

Message WHITE BLUE

Preset

No.
Window Fore Color Back Color



3.  SYSTEM INITIALIZATION

3-5

3) Select [Fore Color].

4) Use ← or → key to select a color. 

5) Select [Back Color].

6) Use ← or → key to select a color. 

7) To select colors for other windows repeat steps 2)-6).

10. Press the Enter key to show the [Update] window.

11. [Yes] is selected; press the Enter key.

12. Long-press the Esc key to return to the standby display.

To restore all default color settings, select [Window Color] from the [Terminal Setup] 

menu, select [Load Default], press the Enter key then press the Enter key again.

1:
2:
|
|
|
|
|
|
|

MENU

< [1] UNTITLED1 >

EDIT BASE WINDOW

   CAUTION
MESSAGE

File    Edit    Transmit    EGC    Reports    Logs    Options    Setup                      StopAlarm
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3.3 Login and Logout

Each time the terminal unit is turned on, login your vessel with the Inmarsat C system 

to enable communications between your vessel and an LES. This is called login.

Note that you can transmit or receive EGC messages even if you are not logged in.

If you will not be using the FELCOM for a prolonged period, you should logout from 

the Inmarsat C system, before turning off the communication unit. The Inmarsat C sys-

tem will then register you as inactive, notifying anyone trying to call you that you are 

currently unavailable. If you do not log out before turning off the power, some LESs 

may attempt to send a message to you. They may charge your correspondent, even 

if you don’t receive the message.

3.3.1 Login

1. Confirm that [SYNC (NCS)] appears at the bottom of the screen.

2. Press the F7 key to display the [Options] menu.

3. Press the 2 key to display the [Login] screen.

Note: The terminal unit must be “idle” to login. ("Current State: IDLE" appears at 

the bottom of the screen.) When it is not idle, "Ignored: MES is not idle." appears. 

Long-press the Esc key to return to the standby display. Wait until the terminal unit 

becomes idle.

4. [Yes] is selected in the [Start] window; press the Enter key.

Options 

1. Position 

2. Login

3. Logout

4. Abort

5. Select NCS

6. Ocean Region

7. LES Information

8. Test

9. Maintenance

Login

Start

NoYes
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5. Login begins, and the screen should look something like the one shown below.

When login is completed, the message "Successful Login." appears. Then, the 

system goes into “Idle” status and [LOGIN] stops flashing.

6. Long-press the Esc key to return to the standby display.

3.3.2 Logout

1. Press the F7 and 3 keys to display the [Logout] screen.

2. [Yes] is selected in the [Start] window; press the Enter key. The message "Start-

ing Logout Process. Press any key to escape." appears.

3. When logout is completed, the message "Successful Logout." appears and the 

[Current State] indication changes from [LOGOUT] to [IDLE]. Then, turn off the 

FELCOM.

Current State: LOGIN

CALLING

DCE F19 Ver. **

02-02-25  02:02 (UTC)

        LAT:   34:30.00N

        LON: 135:30.00E

SYNC ( NCS )

NCS: IOR        LOGIN

Options

Login

Starting Login Process.

Press any key to escape.

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup                     StopAlarm

LOGIN replaces IDLE.
Flashing during login

Logout

Start

NoYes
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3.4 EGC Settings

3.4.1 What is the EGC (Enhanced Group Call) service?

The EGC service enables EGC information providers to send SafetyNETTM, Fleet-

NETTM and System messages via an LES to a specific groups of ships, or to all ships 

within a defined geographical area.

Each type of EGC service is sent as follows:

There are three types of EGC services:

1) SafetyNETTM

This provides a means for information providers to distribute Maritime Safety Infor-

mation (MSI) from shore-to-ship. Authorized information providers include:

2) FleetNETTM

This service allows authorized information providers such as commercial subscrip-

tion services, shipping companies and governments, which have registered with a 

LES that supports FleetNETTM, to broadcast messages to selected group of 

MESs. Typical applications of FleetNETTM are

• The information provider prepares the message, and then accesses the appro-

priate Country of the international telex network to send the message to an LES.

• The LES processes and forwards it to the NCS for the ocean region designated 

by the provider.

• Then, the NCS broadcasts the message throughout the ocean region. (The op-

erator may select the EGC messages to receive by position (one position) and 

geographical position (nine areas). For further details see section 3.4.2.)

• Hydrographic Offices, for navigational warnings
• National Weather Services, for meteorological warnings and forecasts

• Rescue Co-ordination Center, for shore-to-ship distress alerts and other urgent infor-

mation

• International Ice Patrol, for North Atlantic ice hazards

• Fleet or company broadcasts

• News broadcasts

• Commercial weather service

• Government broadcasts to all vessels on a country’s registration

Satellite

NCS common channel

MES

MES

MES

NCS

Ch1

Ch2

Ch3

LES1

LES2

LES3

Ch1-Ch3 are dedicated

channels for each LES.

Information Provider

* Meteorological body

* Navtex station

* Coast guard

* Rescue center

* Shipping company, etc.
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3) System: EGC system-related is sent by Inmarsat to certain ship groups and geo-

graphical areas.

3.4.2 EGC settings

The FELCOM receives EGC messages directed to its present position and Navarea 

without further programming. The EGC Setup screen lets you select additional areas 

for which to receive messages and also the Navtex station and type of message for 

Coastal Warning (NAVTEX Re-broadcast).

1. Press the F8 and 4 keys to display the [EGC Setup] menu.

2. The cursor is selecting [Additional Position], where you can enter the L/L position 

of an ocean region you want to receive broadcasts about. Press the Enter key to 

open the additional position entry window.

3. Enter position as follows:

1) Enter latitude (xx°xxx).

2) Press the N or S key as appropriate to enter coordinate.

3) Enter longitude (xxx°xxx).

4) Press the E or W key as appropriate to enter coordinate.

4. Press the Enter key to close the window.

5. Select [Navarea] and press the Enter key to open the nav area entry window.

6. Enter additional Navarea(s) (I-XX1, max. of nine) in two digits, referring to the il-

lustration below for code number. 

EGC Setup

Ice reports

Meteo. forecasts

Pilot service

LORAN messages

OFF

OFF

OFF

OFF

SATNAV messages

Other navaid msg

QRU (no message)

OFF

OFF

OFF

    :               :

ON

Receive EGC Area

Additional Position                        - -:- - -  - - -:- - -

Navarea(s)/Metarea(s)

Fixed Area                                       - - - - - - - -   - - - - - - - -  - - - - - - - -

Waypoint (from NAV Equipment)

Coastal Warnings

Station Code

Type of Message (Can't reject other report)
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7. Press the Enter key to close the window.

Note: [Fixed Area] is where you enter fixed areas (max. 3) for chart correction ser-

vice. However, this service is not yet available; enter no data.

8. Select [Station Code] then press the Enter key.

9. Enter the Navtex station code (A-Z) of the navarea, in upper case alphabet. For 

details about Navtex stations, consult the operator’s manual of the Navtex receiv-

er. Press the Enter key to close the window.

10. Select the message type to receive: Use the arrow keys to select message type, 

press the Enter key, select [ON] or [OFF] as appropriate then press the Enter key.

Note: The Navtex messages “Coastal navigational information,” “Meteorological

warning” and “Search and rescue alert” (they do not appear on the [EGC Setup] 

menu) must always be received.

11. Press the Esc key to show the [Update] window.

12. [Yes] is selected; press the Enter key.

13. Long-press the Esc key to return to the standby display.
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3.4.3 How to add EGC channels

The EGC Channel List stores EGC channels. There are currently four EGC channels, 

one for each satellite. These four channels are pre-programmed into the unit and 

marked in the [EGC Channel List] with asterisks. When more EGC channels become 

available you can add them to the list as below.

1. Press the F8, 8 and 3 keys to show the [EGC 

Channel List].

2. Use the arrow keys to put the cursor where there 

is no data entered. Current EGC channels are 

marked with an asterisk. These channels cannot 

be changed.

3. Press the Enter key to open the EGC channel 

list entry screen.

4. Enter EGC channel frequency code then press the Enter key. The EGC channel 

frequency code range is 6000-14000.

5. Press the Esc key to open the [Update] window.

6. [Yes] is selected; press the Enter key.

Note: If the EGC channel frequency code entered is invalid, the message "Input 

Error: Channel No." appears. Clear the error message by pressing the Esc key. 

Put the cursor at the invalid frequency, press the Enter key then enter correct fre-

quency code.

7. Long-press the Esc key twice to return to the standby display.

3.4.4 How to automatically save and print EGC messages

How to automatically save EGC messages

1. Press the F8 and 5 keys to display the [Auto Mode Setup] menu.

2. Select [Auto EGC Message Save] then press the Enter key.

3. Select the message to process then press the Enter key. 

4. Select [ON] or [OFF] as appropriate then press the Enter key.

5. Long-press the Esc key to return to the standby display.

EGC Channel List

12580* 10840* 11088*

ENTER: Set   ESC: Quit

11080*

Auto Communication Log Print OFF

Receive Alarm OFF

Auto Receive Message Save OFF

Auto Receive Message Print OFF

Data Report & Polling Print OFF

Auto EGC Message Save

Auto EGC Message Print 

Auto Mode Setup 

Auto EGC Message Save

System OFF

FleetNET OFF

SafetyNET (Safety) OFF

SafetyNET (Urgent & Distress) ON
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How to automatically print EGC messages

FleetNETTM and SafetyNETTM messages can be automatically printed. 

1. Press the F8 and 5 keys to display the [Auto Mode Setup] menu.

2. Select [Auto EGC Message Print] then press the Enter key.

3. Select the message to process then press the En-

ter key. 

4. Select [ON] or [OFF] as appropriate then press 

the Enter key.

5. Long-press the Esc key three times to return to 

the standby display.

3.5 How to Add NCS Channels

This section shows you how to add NCS channels to the [NCS Channel List]. 19 chan-

nels can be listed per each ocean region. Currently, there are four NCS channels, and 

they are marked with asterisks in the list. Add NCS channels to the list as below when 

they become operational.

1. Press the F8, 8 and 4 keys to display the [NCS Channel List].

2. Use the arrow keys to put the cursor in a blank [ID] column.

3. Press the Enter key to open the data entry window.

4. Enter NCS channel ID number, in two digits (leading zero is not necessary). The 

ID number range is 45-63.

5. Press the Enter key to close the window.

6. Press the → key to select the [FREQ] column then press the Enter key to open 

the frequency input window.

7. Enter NCS channel frequency code. The frequency code range is 6000-14000.

8. Press the Enter key to close the window.

9. Press the Esc key to open the [Update] window.

10. [Yes] is selected; press the Enter key to register input.

Note: If the ID or frequency code entered is invalid the message "Input Error: NCS 

ID" (for invalid ID) or "Input Error: Channel No." (for invalid frequency code) ap-

pears. Clear the error message by pressing the Esc key. Put the cursor at the in-

valid ID or frequency code. Then, press the Enter key and enter correct ID or 

frequency code.

11. Long-press the Esc key to return to the standby display.

Auto EGC Message Print

System OFF

FleetNET OFF

SafetyNET (Safety) OFF

SafetyNET (Urgent & Distress) OFF

NCS Channel List

No AOR (WEST)

FREQ

11080*01

02

03

04

05

06

07

08

ENTER: Set   ESC: Quit

AOR (EAST)

FREQ

12580*

ID

144

1

1

1

1

1

1

1

POR

FREQ

12580*

ID

244

2

2

2

2

2

2

2

IOR

FREQ

10840*

ID

344

3

3

3

3

3

3

3

ID

044

0

0

0

0

0

0

0
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3.6 LES List

The LES List provides for storage of 44 LES names per ocean region.

3.6.1 How to register an LES to the LES list

When a new LES is added, add it to the [LES List] as shown below. See the Appendix 

4 for a list of LES.

1. Press the F8, 8 and 2 keys to display the [LES List].

2. Use the arrow keys to put the cursor where desired. For example, select 005 in 

the AOR(WEST) column.

3. Press the Enter key.

4. [Name] is selected; press the Enter key to open the text entry window.

5. Enter LES name (maximum 15 characters) then press the Enter key.

6. Select [Remarks] then press the Enter key.

7. Enter remarks (max. 20 characters) then press the Enter key.

8. Press the Esc key to return to the [LES List].

9. Repeat steps 2-8 to enter another LES.

10. Long-press the Esc key to return to the standby display.

 LES List

Ctrl+P: Print   ENTER: List Entry   ESC: Quit

AOR (WEST)

Name

Vizada 101

Stratos Global

KDDI

Vizada (NOR)

Telecom Italia

AOR (EAST)

Name

Vizada 201

Stratos Global

KDDI

Vizada (NOR)

POR

Name

Telenor S.S.Inc

Stratos Global

KDDI

Vizada (NOR)

OTE (Greece)

VSNL (India)

IOR

Name

No

00

01

02

03

04

05

06

07

Vizada 001

Stratos Global

KDDI

Vizada (NOR)

LES ID:   XXX

0: AOR(WEST)
1: AOR(EAST)
2: POR
3: IOR

No. (00-43)Put cursor here.

: KDDI

: 005

: JAPAN

Name

Remarks

Erase the Name to delete this LES.
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3.6.2 How to edit the LES list

1. Press the F8, 8 and 2 keys to display the [LES List].

2. Select the LES to edit then press the Enter key.

3. Do one of the following:

Change station name: Select [Name] then press the Enter key. Press the Back-

Space key to erase name, enter new name then press the Enter key.

Delete station name: Select [Name] then press the Enter key. Press the Back-

Space key to erase name then press the Enter key.

4. Press the Esc key to quit.

5. Long-press the Esc key to return to the standby display.

3.6.3 How to print the LES list

1. Press the F8, 8 and 2 keys to display the [LES List].

2. Press the P key while pressing the Ctrl key.

3. Long-press the Esc key to return to the standby display.

3.7 Station List

3.7.1 How to add stations to the station list

The FELCOM provides an address book for storing 99 station IDs. Enter station IDs 

as shown below.

1. Press the F8, 8 and 1 keys to display the [Station List].

Note: You may sort the list by group name, station name or communication type 

as follows:

Group name: Each press of Ctrl+G sorts the list by group name, in ascending or 

descending order.

Station name: Each press of Ctrl+N sorts the list by station name, in ascending 

or descending order.

Comm. type: Each press of Ctrl+T sorts the list by communication type, in as-

cending or descending order.

Station List

Ctrl+P: PrintPage Up, Page Down: Move

Sort (Ctrl+G: Group, Ctrl+N: Station Name, Ctrl+T: Type)

Group Station Name       Type       Code ID / Address

01

02

03

04

05

06

07

08

    abc

    xyz

    Seagull

E-Mail

E-Mail

TELEX/

abc@ furuno.co.jp

xyz@ furuno.co.jp

584     463609999
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2. Press the ↓ key to put the cursor on a blank line then press the Enter key.

3. Press the Enter key to open the station group entry window.

4. Enter station group name (max. five characters) then press the Enter key.

5. Select [Station Name] then press the Enter key.

6. Enter station name then press the Enter key.

7. Select [Destination Type] then press the Enter key.

8. Select destination type desired then press the Enter key.

TELEX/MES: Telex communication/Mobile Earth Station (Ship-to-Ship Telex)

FAX: Facsimile service

E-Mail: E-mail (electronic mail) Service

SMS: Circuit Switched Data Network-not used.

PSDN: Packet Switched Data Network to an office computer via a data network 

using X.25 standard.

X400: For future use

DNID: Data Network ID. Not used.

Special: Ship-to shore requests for safety service, accessed by using special 2-

digit codes

9. Press the Enter key to close the window. Follow appropriate procedure on the 

next several pages.

Procedure for telex

1. Select [Country Code] then press the Enter key.

2. For ship-to-shore telex, enter international telex country code; for ship-to-ship tel-

ex, enter ocean region. Press the Enter key. A list of international telex country 

codes appears in the Appendix 4.

AOR-East: 581, POR: 582, IOR: 583, AOR-West: 584

3. Select [Station ID] then press the Enter key.

Station Group 

Station Name

Destination Type    TELEX/MES

Prefix Code

Country Code

Station ID

Modem Type

E-Mail Address

Remarks

Erase the Name to delete this station.

TELEX/MES

FAX

E-Mail

SMS

PSDN

X400

DNID

Special

TELEX/MES (Prefixed)

FAX  (Prefixed)

PSDN  (Prefixed)

X400  (Prefixed)

DNID  (Prefixed)

Special  (Prefixed)
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4. Enter telex subscriber number (for ship-to-shore) or MES Inmarsat Mobile Num-

ber (for ship-to-ship) then press the Enter key. A maximum of 15 characters can 

be used, including space.

5. Select [Remarks] then press the Enter key.

6. Enter remarks then press the Enter key. A maximum of 20 characters can be 

used.

7. Press the Enter key to close the window.

8. Long-press the Esc key to return to the standby display.

Procedure for Fax

1. Select [Country Code] then press the Enter key.

2. For ship-to-shore fax, enter international telex country code; for ship-to-ship fax, 

enter ocean region. Press the Enter key. A list of international country codes ap-

pears in the Appendix 4.

3. Select [Station ID] then press the Enter key.

4. Enter the fax number then press the Enter key.

5. Select [Modem Type] then press the Enter key.

6. Select the modem type used by the subscriber then press the Enter key. For a 

landline fax or a fax-equipped Inmarsat B MES, select [T30 FAX].

7. Select [Remarks] then press the Enter key.

8. Enter remarks then press the Enter key. A maximum of 20 characters can be 

used.

9. Press the Esc key to return to the Station List.

10. Long-press the Esc key to return to the standby display.

Procedure for e-mail

1. Select [E-mail Address] then press the Enter key.

2. Enter the e-mail address of the recipient then press the Enter key. 

3. Select [Remarks] then press the Enter key.

4. Enter remarks then press the Enter key. A maximum of 20 characters can be 

used.

5. To enter another e-mail address, repeat the procedure from step 2 on page 3-15.

6. Long-press the Esc key to return to the standby display.

Procedure for SMS

1. Select [Address] then press the Enter key.

Modem Type

  300bps Duplex

1200bps Duplex

2400bps Duplex

  600/1200bps

2400/1200bps

2400bps Duplex

4800/2400bps

9600bps Duplex

T30

V21

V22

V22B 

V23

V26B 

V26T

V27T

V32

Other

FAX

V.21

V.22

V.22bis

V.23

V.26bis

V.26ter

V.27ter

V.32
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2. Enter the recipient’s mobile phone number, beginning with the country code, then 

press the Enter key.

3. Select [Remarks] then press the Enter key.

4. Enter remarks then press the Enter key. A max. of 20 characters can be used.

5. Press the Esc key to return to the station list.

6. To enter another SMS recipient, repeat the procedure from step 2 on page 3-15.

7. Long-press the Esc key to return to the standby display.

3.7.2 How to edit the station list

1. Press the F8, 8 and 1 keys to display the [Station List].

2. Select a station then press the Enter key.

3. Do one of the following:

Change station name: Select [Station Name] then press the Enter key. Press the 

BackSpace key to erase name, enter new name then press the Enter key.

Delete station name: Select [Station Name] then press the Enter key. Press the 

BackSpace key to erase name then press the Enter key.

4. Press the Esc key to save the changes.

5. Long-press the Esc key to return to the standby display.

3.7.3 How to print the station list

1. Press the F8, 8 and 1 keys to display the [Station List].

2. Press the P key while pressing the Ctrl key.

3. Long-press the Esc key to return to the standby display.

3.8 How to Enter Position

When there is no navigation data or the Nav Port is disabled, enter ship’s position 

manually as follows:

1. Press the F7 and 1 keys.

2. Press the Enter key to open the latitude entry 

window.

3. Enter latitude (XX°XX.XX), press the N or S 

key as appropriate then press the Enter key.

4. Select [LON], press the Enter key, enter longitude (XXX°XX.XX), press the E or 

W key as appropriate then press the Enter key.

5. Select [Update Time] then press the Enter key. Enter the current time then press 

the Enter key.

6. Press the Esc key to open the [Update] window.

7. [Yes] is selected; press the Enter key to update position and close the menu. 

 The position entered appears at the bottom right corner of the system status monitor 

screen.

34:30.00N

135:00.00E

LAT

LON

Update Time 09:40 11-11-12 (YY-MM-DD)

Ship Position
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3.9 How to Create a Directory

Incoming and outgoing messages may be saved to the hard disk. If no directory is 

specified, all messages are saved to the My Documents folder (in Windows Vista®, 

messages are saved to the FELCOM folder in Documents). 

3.9.1 How to create a directory for message storage

1. Press the F8 and 8 keys to open the [Directories] menu.

2. Select [Message Directory] then press the Enter key.

3. Click the [New Folder] button.

4. Enter directory name then click the [OK] button. 

Received messages are saved to the directory created here. 

To specify where to store EGC messages, select [EGC Message Directory] at step 

2 then complete the procedure.

To delete a directory, select the directory then press the Delete button.

Directories

Message Directory

EGC Message Directory

CancelNew Folder (M)

CancelNew Folder (M)

New Folder
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3.9.2 How to specify the directory for message storage

1. Press the F8 and 7 keys to open the [Directories] menu.

2. Select [Message Directory] then press the Enter key.

3. Select the directory where to store messages then click the [OK] button.

Note 1: The name of each message is automatically saved in the directory assigned, 

and the file name is with the year, month and day (YYYY:MM:DD) the message was 

received.

Note 2: To specify the directory where to store EGC messages, select [EGC Message 

Directory] at step 2.

CancelNew Folder (M)
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3.10 E-mail Service/SMS Station List

E-mail service providers and SMS stations are already registered in the FELCOM. To 

add new e-mail service provider or SMS stations, follow the procedure below.

1. Press the F8, 7 and 5 keys to show the [E-Mail/SMS Service List].

2. Select a blank line in the [LES Name] column then press the Enter key.

3. Press the Enter key to open the [Service LES Name] entry window.

4. Enter the name of the LES that provides the e-mail service then press the Enter 

key.

5. Select [Service ID (E-Mail)] then press the Enter key.

6. Enter the service ID then press the Enter key.

7. Select [Service ID (SMS)] then press the Enter key.

8. Enter the service ID then press the Enter key.

9. Select [LES ID (AORW)] then press the Enter key.

10. Enter the LES ID for AORW then press the Enter key.

11. Enter the LES IDs for AORE, POR and IOR.

12. Select [To:] then press the Enter key.

13. Type appropriate “To” header then press the Enter key.

14. Select [Cc:] then press the Enter key.

15. Type appropriate “Cc” then press the Enter key.

16. Select [Subject:] then press the Enter key.

17. Type appropriate “Subject” then press the Enter key.

E-Mail/SMS Service List

LES Name AOR.W  AOR.E   POR       IOR

01

02

03

04

05

06

07

08

Telenor S.S.Inc

Stratos (NED)

Stratos Global

Vizada (NOR)

KDDI

Singapore T.

Vizada (France)

Stratos (AUS)

001       101         201         301

012       112         212       312

002       102         202       302

004       104         204       304

003       103         203       303

                            210       328

021       121         221       321

022       122         222       322

OFF

Service LES Name
Service ID (E-Mail)
                  (SMS)
LES ID (AORW)

 (AORE)
 (POR)
 (IOR)

To:
Cc:
Subject:
Separator:
SMS:
Attach File (MIME)

Enter data for LES which offers e-mail services. 

For details, contact LES directly.

Example: Enter data of the Vizada to do SMS mail 

or e-mail service:

Service LES Name Vizada (NOR)

Service ID (e-mail) 28

Service ID (SMS)  66

LES ID (AORW)  004

  AORE   104

  POR   204

  IOR   304

To:   TO:

Cc:   CC:

Subject:   SUBJECT:

Separator:  Blank

SMS:   Blank

Attach FIle (MIME) ON(UUENCODE)
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18. Select [Separator:] then press the Enter key.

19. Type appropriate “Separator” (for example, blank space, STX, etc.) then press the 

Enter key.

20. Select [SMS:] then press the Enter key.

21. Type appropriate “Separator” (for example, blank space, STX, etc.) then press the 

Enter key.

22.  If it is necessary to enter the special Prefix “sms+” before telephone number, type 

it here. For example, for Singapore Telecom, enter sms+8190123456789.

23. Select [Attach File (MIME] then press the Enter key.

24. Select [ON(BASE64)], [ON(UUENCODE)] or [OFF] as appropriate then press the 

Enter key. BASE64: General text converter, UUENCODE: UNIX text converter.

25. Long-press the Esc key to return to the standby display.

3.11 E-mail Settings

Choose the LES where to forward e-mail. Also, you may need to register with an LES 

which provides e-mail services. 

1. Press the F8, 6 and Enter keys to open the [E-Mail/SMS Service List].

2. Choose the LES where to send e-mail then press the Enter key.

3. Long-press the Esc key to return to the standby display.

E-Mail/SMS Service List

LES Name AOR.W  AOR.E   POR       IOR

01

02

03

04

05

06

07

08

Telenor S.S.Inc

Stratos (NED)

Stratos Global

Vizada (NOR)

KDDI

Singapore T.

Vizada (France)

Stratos (AUS)

001        101           201           301

012       112         212       312

002       102         202       302

004       104         204       304

003       103         203       303

                            210       328

021       121         221       321

022       122         222       322
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3.12 How to Export, Import System Settings

System settings (as well as messages) may be saved to a selected folder and loaded 

onto the terminal unit. This is useful for having backup copies of system settings.

3.12.1 How to export system settings

1. Press the F8, 8 and 6 keys to show the [Export/Import] menu.

2. Select [Export] then press the Enter key.

3. Select the item to export then press the Enter key.

Sent Message: Export a maximum of 50 sent messages.

Received Message: Export a maximum of 50 received 

messages.

EGC Message: Export a maximum of 50 EGC messages.

Station List: Export the [Station List].

LES List: Export the [LES List].

E-Mail/SMS Service List: Export the [E-mail/SMS Ser-

vice List].

Test: Export a maximum of five each of PV test and diagnostic test.

Maintenance: Export a maximum of 5000 entries of the [Current Position Log].

Settings: Export the settings of VMS*, SSAS*, EGC, Network, Communication 

Unit and Terminal Unit. *VMS and SSAS require access rights.

4. Select the destination then click [OK]. The message "OK to Export?" appears.

5. Select [Yes] then press the Enter key to save chosen system setting to the select-

ed folder.

3.12.2 How to import system settings

1. Press the F8, 8 and 6 keys to show the [Export/Import] menu.

2. Select [Import] then press the Enter key.

3. Select the item to import then press the Enter key.

Station List: Import the [Station List].

LES List: Import the [LES List].

E-Mail/SMS Service List: Import the [E-mail/SMS Service List].

Settings: Import settings (VMS*, SSAS, EGC, Network, Communication Unit and 

Terminal Unit). *VMS requires access rights.

4. Select the folder that contains the item to import then click [OK]. The message 

"OK to import?" appears.

5. Select [Yes] and press the Enter key to save import item to the selected folder.

Export

1. Sent Message

2. Received Message

3. EGC Message

4. Station List

5. LES List

6. E-Mail/SMS Service List

7. Test

8. Maintenance

9. Settings

Import

1. Station List

2. LES List

3. E-Mail/SMS Service List

4. Settings
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4. FILE OPERATIONS

This chapter describes how prepare, edit, save and print files (messages).

4.1 Files and Working Areas

To create a new message it is necessary to open a new file. After a new file is opened, 

one of two working areas in the internal memory is secured to create the message. 

The term “open a file” also refers to the loading of a prepared file into a working area.

When you remove a file from a working area this is called “closing a file.”

4.2 How to Prepare Files

There are two types of files: routine and confidential. Files can be assigned a file name 

and saved to the hard disk for later use. The maximum message size is 32 kilobytes.

4.2.1 How to prepare a routine file

1. Press the F1 key to open the [File] menu.

FELCOM’s 

memory

FILE 1 1

2

Screen

HARD DISK MEMORY

FILE 2

FILE 3

INTERNAL MEMORY

FELCOM 19’s

TWO WORKING AREAS

Display

Can select one 

for display.

(Change Window

on Edit menu)

File

1. New

2. Open

3. Close

4. Save

5. Delete

6. Rename

7. Print

8. Print Setting

ALT-N

ALT-O

ALT-Q

ALT-S

ALT-D

ALT-P

9. MIME (Decode)
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2. Press the 1 key to select [New]. The display should now look something like the 

illustration below.

Note: When two working areas are opened and you try to open a third file, the 

message "Save this message" appears. When this occurs close an open file to 

free a working area.

3. The cursor is on the first line. Type your message.

4. To transmit the message you have just prepared, go to section 5.1.2. To save it 

to the hard disk, for future transmission, go to section 4.3.2.

4.2.2 How to prepare a confidential file

If communicating with another FELCOM19, you can prepare a confidential message 

by entering “S???-addressee code(-password):” in the first line of message text. You 

can also receive confidential messages containing this header from a land subscriber 

or any MES which uses the FELCOM19.

There are two types of confidential messages: message with addressee code and 

message with both addressee code and password.

When the FELCOM receives a confidential message, the message is neither dis-

played nor printed immediately. To display or print the contents of a confidential mes-

sage, the recipient executes the procedure shown in section 5.2.3.

Addressee code and password

Caller and recipient agree beforehand on both the addressee code and the password. 

The addressee code might be the title of the recipient; for example, CAPTAIN. The 

password could be the classification of the message; for example, SECRET.

How to prepare a message with addressee code

Type the addressee code as shown in the illustration below and then type the text of 

message.

<[1] UNTITLED1>

0001|

TELEX

----*---------+---------+---------+---------+---------+---------+---------<

1 Char.       [ Line        1/        1    Col.       1  ]  [Insert         ]

Cursor can be a square or an underline.

S???-addressee code:  (text of message)

Be sure to enter colon.

maximum 8 characters
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How to prepare a message with both addressee code and password

Type the addressee code as shown in the illustration below and then type the text of 

message.

The recipient enters the password to view the contents of the message.

4.2.3 Editor menu settings

The Editor menu sets the parameters of the text editor.

1. Press the F8 key to display the [Setup] menu then press the 2 key to show the 

[Editor Setup] menu.

2. Set each item as required, referring to the descriptions below.

Text Mode: Select [Telex] to create a telex message. Only upper case alphabet 

is permitted in telex. Use [Ascii] to create an e-mail message. Upper and lower 

case alphabet may be used in an e-mail.

Edit Mode: Select [Insert] (insert character at cursor location) or [Overwrite] (write 

over character at cursor location).

Word Wrap: Turn automatic hyphenation at the end of a line on or off

Line No.: Turn the line number display on or off. See the illustration below.

Tab Width: Set the horizontal tab width, two, four or eight tabs per line.

Column Width: Set 69 for telex, 40 to 80 for ASCII.

Cursor Type: Select the cursor configuration, block or underline.

Scroll: Sets how much the screen moves up over the page ([Full Screen] or [Half 

Screen]) when the Page Up or Page Down key is operated.

S???-addressee code-password: (text of message)

Be sure to enter colon.

maximum 8 characters each

Editor Setup

Ascii

Insert

ON

ON

4 Char

69

Block

Full Screen

Text Mode 

Edit Mode

Word Wrap

Line No. 

Tab Width 

Column Width

Cursor Type

Scroll

<[1] UNTITLED1>

0001|

Cursor can be a square or an underline.

Line Number

Displayed if Line No. is turned on in

Editor Setup menu. 
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4.2.4 Text operations

How to cut and paste text

1. Use the arrow keys to place the cursor on the first character of the text to cut.

2. Highlight the text to be cut by pressing the → key while pressing and holding the 

Shift key. You can use the ← or → key to adjust the highlight. The figure below 

shows the appearance of highlighted text.

3. Press the F2 key to open the [Edit] menu.

4. Press the 1 key to select [Cut]. The highlighted text is cut 

and the remaining text is reformatted. If you make a mis-

take, you can immediately restore the text by pressing 

the Insert key.

5. To move the text to a new location after it has been cut, 

place the cursor at the exact spot in the message where 

the cut text is to start. When the text cursor is placed cor-

rectly, press the F2 key and then the 3 (Paste) key.

How to copy and paste text

1. Select the text to copy.

2. Press the F2 key to open the [Edit] menu.

3. Press the 2 key to select [Copy]. The selected text is copied to the clipboard.

4. Place the cursor at the exact spot on the message where the copied text is to start.

5. Press the F2 key followed by the 3 key. The text is inserted at the cursor location.

Insert (with Citation)

When you reply to a received message, you can insert “>” at the head of the received 

message to distinguish it from your message.

1. Press the F2 key to open the [Edit] menu.

2. Press the 4 key.

3. Select the file to use. 

4. Press the Enter key.

Select All

Select the entire current file for cut and copy:

1. Press the F2 key to open the [Edit] menu.

2. Press the 5 key.

<[1] UNTITLED1>

Highlight
0001 WE ARE CONFIDENT THAT YOU WILL ENJOY MANY YEARS OF OPERATION WITH

0002 THIS INMARSAT STATION CONGRATULATIONS ON YOUR CHOICE

0003 CONGRATULATIONS ON YOUR CHOICE OF FURUNO FELCOM 

Edit

1. Cut               

2. Copy            

3. Paste            

4. Insert (With Citation)

5. Select All      

6. Search or Replace

7. Goto Line

8. Time or Pos. Ins

9. Change Window  

DEL

ALT-C

INS

ALT-A

ALT-V
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Search and replace

How to search text

1. At the [Edit] menu, press the 6 key to select [Search or 

Replace].

2. Press the 1 key to select [1. Search].

3. [Search Word] is selected; press the Enter key to show 

the search word entry window.

4. Type the word to search then press the Enter key.

5. Select [Direction] then press the Enter key.

6. Select [Forward] or [Back] to select the direction to search from the cursor location 

then press the Enter key.

7. Press the Esc key to show the [Search Start] confirmation window.

8. [Yes] is selected; press the Enter key to start the search.

When the unit finds the word, the cursor stops at the first character of the word. If 

the string could not be found, the message "Not Found (To Quit: ESC)" appears. 

Press the Esc key to quit.

9. To continue the search, press the Enter key. 

How to replace text

1. At the [Edit] menu, press the 6 key to select [Search or Replace].

2. Press the 2 key to select [2. Replace].

3. [Search Word] is selected; press the Enter key to show 

the search word entry window.

4. Type the word to search then press the Enter key.

5. Select [Replace Word] then press the Enter key.

6. Enter the replace word then press the Enter key.

7. Select [Direction] then press the Enter key.

8. Select the direction (forward or back) to search from the cursor location press the 

Enter key. 

9. Select [Query or ALL] then press the Enter key.

10. Select [Query] or [ALL].

Query: Stop at each occurrence of word to answer yes or no to replacement. 

ALL: Replace every occurrence of word without stopping to confirm. 

11. Press the Esc key to show the [Replace Start] confirmation window. 

12. [Yes] is selected; press the Enter key to start the replacement.

If you selected [ALL] at step 10, all occurrences of the search word are replaced 

with the replace word. If the string could not be found, the message "Not Found 

(To quit: ESC)" appears. Press the Esc key to quit. 

If you selected [Query] at step 10, the message "Replace OK? (OK: ENTER Pass: 

SPACE To quit: ESC)" appears when the search word is found. Press the Enter 

key to replace the word, or hit the Spacebar to go to the next occurrence of the 

search word. 

1. Search                Alt-F

2. Replace               Alt-R

Search or Replace

Search Word

Direction    Forward

Search 

Search Word

Replace Word

Direction Forward

Query or ALL Query

Replace 
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Go to line

Move the cursor to the desired line in the current file. 

• Top of text: Go to top of text

• End of text: Go to end of text

• Go to line: Specify line number to go to.

Press the F2 and 7 keys. Put the cursor where desired then press the Enter key.

Time or Pos. Ins

Insert time or position in a sentence 

1. At the [Edit] menu, press the 8 key to select [Time or Pos. 

Ins.] 

2. Put the cursor where to insert the information then press the 1 key to insert time 

or the 2 key to insert position.

4.3 How to Save Files

You can save a message two ways: Save it without losing your place on the screen 

(called “save”), or save it before clearing the screen (called “close”).

4.3.1 Save file, retain place on screen

1. Press the F1 and 4 keys.

2. Enter a file name. You can use a maximum of eight characters with extension 

name (three characters). You can not use brackets ([ ]), asterisk (*), comma (,), 

plus (;) or equal sign (=).

3. Press the Enter key to save the file to the 

disk and keep it on the screen.

4.3.2 Save file, clear screen

1. Press the F1 and 3 keys. The message "Save this message?" appears.

2. [Yes] is selected; press the Enter key.

3. Press the Enter key to save the file to the disk and keep it on the screen.

4. Enter a file name at the cursor location.

5. Press the Enter key to save the file and clear the screen.

1. Top of Text   HOME

2. End of Text     END

3. Goto Line

Goto Line 

1. Time

2. Position

Time or Pos. Ins 

<[1] UNTITLED1>

0001|THE FURUNO FELCOM 12 INMARSAT STANDARD C MOBILE EARTH STATION, A

0002|SATELLITE COMMUNICATIONS UNIT PACKAGE FOR VIRTUALLY EVERY VESSEL.

----*---------+---------+---------+---------+---------+---------+---------<

File

ALT-N

ALT-O

ALT-Q

ALT-S

ALT-D

ALT-P

Save

[Settings\xxxx\MyDocuments\FELCOM 19              ]

To View: SPACE   Make Dir: INS      Remove Dir: DEL

<DIR>

<DIR>

<DIR>

864

12-01-25  02:33

12-01-25  02:52

12-01-25  02:59

12-01-25  03:13

     Filename            Size            Date & Time

.

..

EGC

E0970715.001

          4  Files exist                   579584 bytes free

Col.    4  ]      [Insert    ]

period
3 characters

(file name) . (extension name)

8 characters
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4.4 How to Open Files

4.4.1 How to open a file

1. Press the F1 and 2 keys to show the list of files stored on the hard disk.

2. Select a file. 

3. Press the Enter key. 

A few moments later the contents of the file appear on the screen and the title bar 

shows the file name. You may repeat this procedure to load a second file into a work-

ing area.

4.4.2 How to switch between files

You can switch between files by pressing the 9 key (Change Window) on the [Edit] 

menu ([F2]), or pressing Alt+V on the editor screen. 

4.4.3 How to open a file when both working areas are occupied

If both working areas in the memory are occupied when you attempt to open a file, you 

are asked "Save this message?" for the active file.

1. To save the file, press the Enter key to show the [Save] window. If you don’t need 

to save the file, select [No] press the Enter key then go to step 4.

2. To enter the same file name as the edited file, press the Enter key.

3. [Yes] is selected; press the Enter key.

4. Select the file to open then press the Enter key.

    [F2]

     9: Change Window 

or [ALT] + [V]

How to alternate display of files in working area 1 and 2.

FURUNOABC

1

2
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4.5 How to Save a File Under a New Name

1. Open a file referring to section 4.4.1.

2. Edit the file.

3. Press the F1 key then the 3 (Close) or 4 (Save) key as applicable.

4. For [Close], press the Enter key.

5. Press the BackSpace key to delete the original file name. Enter a file name.

6. Press the Enter key.

Note:  Should you decide to save the file under the original name, skip step 5. Over-

write the file by pressing the Enter key, or select [No] then press the Enter key to es-

cape. 

4.6 How to Print Files 

You can print out a hard copy of files stored on the hard disk.

1. Press the F1 and 7 keys to show a list of files stored on the hard disk.

2. Select a file. 

3. Press the Enter key to print the file.

4.7 How to Combine Files

In the example procedure below File A and B are combined.

1. Open file A.

2. Open file B.

3. Put the cursor at the beginning of the file B. While pressing and holding down the 

Shift key, press the ↓ key to highlight the entire file. (You can also select a portion 

of the file.) 

4. Press the C key while holding down the Alt key to place file B on the clipboard. 

5. Press the V key while holding down the Alt key to switch to file A.

6. Press the Insert key. File B is inserted at the top of the file A. 
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4.8 How to Decode an E-Mail Attachment

When you can't read an e-mail attachment because it has been coded by MIME (Mul-

tipurpose Internet Mail Extensions), you may decode it as below. 

1. Save the MIME-coded file to the hard disk. (See section 5.2.5 for the procedure.) 

This step is not necessary if [Auto Receive Message Save] is turned on in the [Au-

to Mode Setup] menu.

2. Press the F1 and 9 keys to select [MIME (Decode)].

3. Select the file to decode then press the Enter key.

4. [Yes] is selected; press the Enter key to decode the file.

5. To change the file name, press the BackSpace key to erase the file name, enter 

a new file name then press the Enter key. After decoding the file the screen looks 

something like the one shown below. 

6. Long-press the Esc key to return to the standby display.

7. Press the F1 and 2 keys.

8. Select the file selected at step 5 then press the Enter key.

Send

[Settings\xxxx\MyDocuments\FELCOM19               ]

To View: SPACE   Make Dir: INS      Remove Dir: DEL

     Filename            Size            Date & Time

.

..

EGC

E0970715.001

E0970715.002

E0970715.003

          4  Files exist                   579584 bytes free

2012-01-25  02:33

2012-01-25  02:52

2012-01-25  02:59

2002-01-25  03:13

2002-01-25  04:16

2002-01-25  06:43

868

372

6794

864

843

833

MIME Decode

Checking 'E0970715.001'. . .

Decode 'ABC.ini'?
Decode

Yes No

File chosen at step 4

File attachment

MIME Decode

Checking 'E0970715.001' . . .

Decode 'ABC.ini'?

Now decoding. . .

Complete.

Decoded 1 file (s).

Press any key to escape.
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5. INMARSAT COMMUNICATIONS

This chapter explains how to send and receive. Before conducting any communica-

tions, be sure to login with the NCS in your area, following the instructions in 

section 3.3.1. 

To send e-mail, register for e-mail services with appropriate LES which provides such 

services. Further, it is necessary to register with appropriate LES to receive e-mail 

from land mail system. For further details, contact appropriate LES.

5.1 How to Send a Message

To send a message, create the message, attach the address of the recipient and then 

send it to the LES. The address of the recipient in the Inmarsat C system is his telex 

number, for transmission via landline, or MES Inmarsat Mobile Number (IMN), when 

sending to a ship. 

The message can be one you have just prepared or one stored on the hard disk. (Mes-

sages cannot be sent by direct keyboard input.) 

5.1.1 Code description

Code can be specified at the terminal unit as follows:

IA5: International alphabet No. 5, ASCII code (7 bit). Specify this code to send English 

containing lower case alphabet.

ITA2: No. 2 international communications alphabet (5 bit). Specify this code for mes-

sage which contains only No. 2 international communications alphabet (see the Ap-

pendix 4). ITA2 code is sent faster than IA5 code. Land-based telex equipment uses 

ITA2. The LES converts all codes into ITA2. Code which cannot be converted is 

shown with the question mark (?).

DATA: Data (8 bit). Use this code to send data. 
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5.1.2 How to send a prepared message

This section explains how to send a message you have just prepared, via fax, telex, 

e-mail or SMS. For 2-digit code services, see the table in section 5.1.6. 

How to send a message to a station registered on the station list

1. Prepare message on the screen.

For e-mail or SMS, set [Text Mode] in the [Editor Setup] menu to [Ascii]. See 

section 4.2.3.

For e-mail attachment, prepare the attachment and save it to the hard disk. SMS 

messages over 160 characters in length are sent in parts. 

2. Press the F3 key to display the [Transmit] menu.

Message Subscriber
Destination

type
Code Remarks

English Inmarsat C MES Telex IA5

Telex Telex IT2

Fax PSTN IA5 Modem type “T30”.

E-mail E-mail IA5

Russian Inmarsat C MES PSND DATA

Fax Not available

E-mail E-mail DATA

Japanese Inmarsat C MES PSDN DATA

Telex Not available

Fax Not available

E-mail E-mail DATA

Data Inmarsat C MES PSDN DATA

Land Network PSDN DATA

Transmit

1. Transmit Message

2. Cancel

3. Request Delivery Status
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3. Press the 1 key to display the [Transmit Message] menu.

4. Select [Station Name] then press the Enter key to open the Station List.

5. Choose a station then press the Enter key. To select multiple stations* (simulta-

neous transmission), select a station and then press the Spacebar. Selected sta-

tions are marked with an asterisk (in case of Telex or FAX). For e-mail address, 

press the Spacebar to select “To,” “Cc,”, Blank, “To” consecutively. * = Max. 10 

telex stations, 7 FAX and 10 e-mail, and one SMS. 

Note 1: Messages having different communication format or prefix code (two-digit 

code) cannot be sent simultaneously.

Note 2: To cancel selection (erase asterisk, To or Cc), select station and press 

the BackSpace key.

Note 3: You may sort the list by group name, station name or communication type 

as follows:

Group name: Each press of Ctrl+G sorts the list by group name, ascending or 

descending order.

Station name: Each press of Ctrl+N sorts the list by station name, in ascending 

or descending order.

Comm. type: Each press of Ctrl+T sorts the list by communication type, in as-

cending or descending order.

Note 4: You may edit the communication charges (see section 3.7.1) from the 

Station List by pressing the Ins key. After editing the charges, press the Esc key. 

"OK to save?" appears; press the Enter key.

1. Transmit Message

2. Cancel

3. Request Delivery Status

Transmit Message

Normal

                                                Size                   24

  TELEX/MES                                 

  82

  65-2111

 303 (KDDI)

 ON

 00:00

 Immediate

 IA5

    

Priority

Message File

Station Name                                                                

Destination Type

Prefix Code

Country/Ocean Code

    Destination

Modem Type

Address

Subject

Attach File

LES ID

Option

     Confirmation 

     Send Delay 

     Delivery Delay

     Code

[   TRANSMIT   ]

ENTER: Station List              DEL:

25 Char.       [ Line        2/        2    Col.       1  ]  [Insert         ]

Station List

Group Station Name Type Code ID / Address

321

343199999

TELEX/

TELEX/

81

583

      FURUNO

      FRNINMBTSTS

01

02

03

04

05

06

07

08

↑ ↓: Select   SPACE: Select Stations   B.SPACE: Cancel Mark   INS: Edit

Sort (Ctrl+G: Group, Ctrl+N: Station Name, Ctrl+T: Type)

E-Mail

E-Mail

Seagull@furuno.co.jp

whale@furuno.co.jp

     Seagull

     whale
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6. For E-mail, follow the procedure below. For other communication formats, go to 

step 7.

1) Select [Subject] then press the Enter key.

2) Type subject then press the Enter key.

3) To attach a file, select [Attach File] then press the Enter key.

4) Press the Enter key to open the file list.

5) Select a file then press the Enter key.

6) Press the Esc key to close the window. 

7. Select [LES ID] then press the Enter key to open the LES setting window. If the 

communication format is e-mail, the LES set in section 3.11 appears. 

8. Select the LES to use then press the Enter key.

9. Select [Confirmation] then press the Enter key.

10. To request notification of delivery from the LES, select [ON]. If not necessary se-

lect [OFF]. Press the Enter key.

11. Select [Send Delay] then press the Enter key.

12. To send a message after a certain delay, enter a time up to 23 hours 59 minutes. 

(The [Send Delay] is used to time message arrival to suit recipient’s office hours.) 

Press the Enter key.

13. Select [Delivery Delay] then press the Enter key.

14. [Delivery Delay] requests the LES for “Immediate” or “Deferred” transmission to 

the recipient designated. Select [Immediate] or [Deferred] then press the Enter 

key. For information on this service, consult with LES where message is to be 

sent. 

15. Select [Code] then press the Enter key.

16. Select [IA5] (for e-mail, fax), [ITA2] (for telex), [DATA] or [SMS] as appropriate 

then press the Enter key.

17. Put the cursor on [TRANSMIT] then press the Enter key to show the [Start] win-

dow.

Select File

ENTER: Select    DEL: Remove

Name

Vizada 201

Stratos Global

KDDI

Vizada (NOR)

Korea Telecom

Remarks

USA

CANADA

JAPAN

NORWAY

SOUTH KOREA

LES ID

201

202

203

204

208
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18. Press the Enter key to send the message to the message queue. (To escape, se-

lect [No] then press the Enter key.) The message "Message is entered in sending 

Queue. Press any key." appears. 

Note 1: If some data has not been entered, the message "Input Error: xx" (xx: er-

ror content) appears.

Note 2:  When you send a message which contains more than 32 KB of data, the 

message "Message file is too large (but enable to send)."

19. Long-press the Esc key to return to the standby display.

The message(s) will be sent according to the [Send Delay] setting. "Current State: 

SENDING" appears at the bottom of the screen while the message is being sent. If the 

message was sent successfully, "Successful Sending message" appears and the TX 

message is printed (if [Confirmation] is OFF). You can view details about the message 

in the [Display Log] (see section 5.3). 

Display log printout example (Confirmation OFF)

When [Confirmation] is ON and you receive a delivery status message, the message 

"Delivery Status received for (file name)." appears and the delivery status message is 

printed.

Display log printout example (Confirmation ON, message delivered)

Display log printout example (Confirmation ON, message not delivered)

Sent Message

DELIVERY CONFIRMATION OFF

Message File : 00FOX.TXT Message Size :    277 characters

LES : Stratos M.N. Date : 02-03-10

Priority : Normal Time : 06:06 (UTC)

Destination : TELEX/MES (Prefixed)  00111222222222222222 (IA5)

Sent Message

DELIVERY CONFIRMED

Message File : 00FOX.TXT Message Size :    277 characters

LES : Stratos M.N. Date : 02-03-10

Priority : Normal Time : 06:06 (UTC)

Destination : TELEX/MES (Prefixed)  00111222222222222222 (IA5)

Sent Message but not delivered

DELIVERY FAILURE: xxx

Message File : 00FOX.TXT Message Size :    277 characters

LES : Stratos M.N. Date : 02-03-10

Priority : Normal Time : 06:06 (UTC)

Destination : TELEX/MES (Prefixed)  00111222222222222222 (IA5)
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Display log printout example (Confirmation ON, delivery status not delivered)

Depending on traffic, it may take at least 15 minutes to receive confirmation.

Status of sent message

The terminal unit displays the status of messages you have sent as follows:

Message send failed. This appears if the message could not be sent because of 

technical reasons such as satellite malfunction, signal degradation, or no reply from 

the LES. Try to send the message again.

Message send rejected. This appears when the LES rejects the message because 

of non-technical reasons such as unpaid subscriber’s fee.

Message send pending. This appears when the circuits at the LES are busy. Your 

message will be sent once a circuit becomes clear.

How to send a message to a station not registered on the station list

1. Prepare message on the screen.

For e-mail or SMS, set [Text Mode] in the [Editor Setup] menu to [Ascii]. See 

section 4.2.3.

For e-mail attachment, prepare the attachment and save it to the hard disk. SMS 

messages over 160 characters in length are sent in parts.

2. Press the F3 and 1 key to display the [Transmit Message] menu.

Sent Message but not delivered

DELIVERY STATUS NOT RECEIVED (in case of timeout)

Message File : 00FOX.TXT Message Size :    277 characters

LES : Stratos M.N. Date : 02-03-10

Priority : Normal Time : 06:06 (UTC)

Destination : TELEX/MES (Prefixed)  00111222222222222222 (IA5)

1. Transmit Message

2. Cancel

3. Request Delivery Status

Transmit Message

Normal

                                                Size                   24

  TELEX/MES                                 

  82

  65-2111

 303 (KDDI)

 ON

 00:00

 Immediate

 IA5

    

Priority

Message File

Station Name                                                                

Destination Type

Prefix Code

Country/Ocean Code

    Destination

Modem Type

Address

Subject

Attach File

LES ID

Option

     Confirmation 

     Send Delay 

     Delivery Delay

     Code

[   TRANSMIT   ]
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3. Select [Destination Type] then press the Enter key.

4. Select destination type then press the Enter key. 

5. Continue the procedure according to the destination type.

Telex/MES: page 5-7

FAX: page 5-7

E-mail: page 5-8

SMS: page 5-8

Destination type: Telex (prefixed)

1. Select [Country/Ocean Code] then press the Enter key.

2. For ship-to-shore telex, enter recipient’s telex country code. For example, to use 

KDDI (Japan), enter 720. For ship-to-ship telex, enter recipient’s ocean region: 

AOR-East, 581; POR, 582; IOR, 583, AOR-West, 584. Press the Enter key after 

entering number. 

3. Select [Destination] then press the Enter key.

4. Type either recipient’s telex subscriber number (ship-to-shore) or IMN (ship-to-

ship) then press the Enter key. 

5. Select [LES ID] then press the Enter key.

6. Select LES then press the Enter key.

7. Continue from step 9 on page 5-4.

Destination type: FAX

1. Select [Country/Ocean Code] then press the Enter key.

2. Enter country code of the recipient then press the Enter key. 

3. Select [Destination] then press the Enter key.

4. Enter the FAX number of the recipient then press the Enter key. 

 

TELEX/MES
FAX
E-Mail
SMS
PSDN
X400
DNID
Special
TELEX/MES (Prefixed)
FAX (Prefixed)
PSDN (Prefixed)
X400 (Prefixed)
DNID (Prefixed)
Special (Prefixed)

Name

Vizada 201

Stratos Global

KDDI

Vizada (NOR)

Korea Telecom

Remarks

USA

CANADA

JAPAN

NORWAY

SOUTH KOREA

LES ID

201

202

203

204

208
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5. Select [Modem Type] then press the Enter key.

6. Select the modem type used by the recipient then press the Enter key. For trans-

mission to landline fax or to fax-equipped Inmarsat B MES, select [T30]. (You can-

not send a FAX to another Inmarsat C MES.)

7. Select [LES ID] then press the Enter key.

8. Select LES then press the Enter key.

9. Continue from step 9 on page 5-4.

Destination type: E-mail

1. Select [Address] then press the Enter key.

2. Type the e-mail address of the recipient then press the Enter key.

3. Select [Subject] then press the Enter key.

4. Type the subject of the e-mail then press the Enter key.

5. To attach a file, select [Attach File] then press the Enter key.

6. Press the Enter key to open the file list window.

7. Select a file then press the Enter key. 

8. Press the Esc key to close the window.

9. Continue from step 9 on page 5-4.

Destination type: SMS

1. Select [Address] then press the Enter key.

2. Type the mobile phone number of the recipient then press the Enter key.

3. Select [LES ID] then press the Enter key.

4. Press the Enter key to close the window.

5. Continue from step 9 on page 5-4.

Modem Type

  300bps Duplex

1200bps Duplex

2400bps Duplex

  600/1200bps

2400/1200bps

2400bps Duplex

4800/2400bps

9600bps Duplex

T30

V21

V22

V22B 

V23

V26B 

V26T

V27T

V32

Other

FAX

V.21

V.22

V.22bis

V.23

V.26bis

V.26ter

V.27ter

V.32
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5.1.3 How to send a file saved to the hard disk

1. Close any open files.

2. Press the F3 and 1 keys to show the [Transmit Message] menu.

3. Select [Message File] then press the Enter key.

4. Select a file then press the Enter key. (You can view a part of a file by tapping the 

Spacebar. After confirming the contents, press the Esc key.)

Note: When an e-mail with attachment is sent, the file volume increases by 1.5 

times because of MIME coding. To lower the charges, select the file to attach from 

the [Message File] and select [DATA] from [Code].

5. To send the message to a station registered on the station list, follow from step 3 

on page 5-3. To send to a station not listed on the station list, follow from step 3 

on page 5-7.

1. Transmit Message

2. Cancel

3. Request Delivery Status

Transmit Message

Normal

                                                Size                   24

  TELEX/MES                                 

  82

  65-2111

 303 (KDDI)

 ON

 00:00

 Immediate

 IA5

    

Priority

Message File

Station Name                                                                

Destination Type

Prefix Code

Country/Ocean Code

    Destination

Modem Type

Address

Subject

Attach File

LES ID

Option

     Confirmation 

     Send Delay 

     Delivery Delay

     Code

[   TRANSMIT   ]

Send

[Settings\xxxx\MyDocuments\FELCOM19               ]

To View: SPACE   Make Dir: INS      Remove Dir: DEL

     Filename            Size            Date & Time

.

..

EGC

E0970715.001

E0970715.002

E0970715.003

          4  Files exist                   579584 bytes free

2012-01-25  02:33

2012-01-25  02:52

2012-01-25  02:59

2002-01-25  03:13

2002-01-25  04:16

2002-01-25  06:43

868

372

6794

864

843

833
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5.1.4 How to cancel transmission on a message awaiting transmis-

sion

As noted earlier a TX message is held in the buffer, usually until it is sent satisfactorily. 

To cancel transmission on a message held in the buffer, do the following: 

1. Press the F3 and 2 keys to show the [Cancel] screen. 

Send status

Waiting: Waiting to send message

Sending: Now sending message

Fail: Failed transmission

Rejected: Message rejected by LES.

Pending: LES circuits occupied.

2. Select the message to cancel then press the Enter key. The [Cancel] prompt ap-

pears.

3. Press the Enter key to cancel the message, or select [No] and press the Enter 

key to escape.

4. Long-press the Esc key to return to the standby display.

5.1.5 How to request delivery status

Automatically receiving delivery status

You can automatically receive delivery status of messages you send to a LES, by se-

lecting “Confirming ON” in the [Transmit Message] menu. Sent messages which re-

quest delivery status appear in the [Message Status List]. The [Message Status List] 

holds delivery status information for 30 messages. When the list is full, the oldest entry 

is deleted to make room for the latest.

1. Press the F3 and 3 keys to show the [Request Delivery Status] list. If there are no 

messages in the list, "No message" appears.

No.

01

Station LES

SANTA PAUL

Cancel

No.   Message File  Destination  LES             Priority   Send  Status

01     S11111.001      INET              Vizada 101  Normal   Sending

Request Delivery Status

Delivery

OCC(002)

Sent

Complete

EEE(001)

Message File

ABC

DEF

GHI

JKL

MNO

edit msg.002

edit msg.001

No.

01

02

03

04

05

06

07

Destination

FURUNO

FURUNO

ASDFASDF

ABCDEFGHIJ

LES

KDDI

KDDI

KDDI

KDDI

KDDI

KDDI

KDDI

Priority

Normal

Normal

Normal

Normal

Normal

Normal

Normal

Send Status

Waiting

Sending

02-02-26    9:40

02-02-25  20:16

02-01-23  16:09

02-01-22    9:48

02-01-20  12:34
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Request delivery status list description

* Some codes are not used depending on LES.

Item Description

No. Message number

Message File File name. 

Station Name of the remote party.

LES The name of the LES that received the message.

Priority Normal only

Send Status The transmission status from the MES (own ship) to the LES; waiting 
or sending, and date and time of transmission for messages sent.

Delivery* The delivery status from the LES to the recipient.
Complete: Message sent successfully
White space: Delivery status not yet received
Reason for no delivery:

OCC(002:)
ABS:
BK:
BMC:
DER:
EOS:
FMT:
IAB:
INC:
INF:
INV:
ITD:
LDE:
LPE:
NA:
NC:
NCH:
NP:
NRC:
RIS:
RDI
RPE:
RSB:
SENT
TMD:
UNK

Delivery tried (twice), but recipient busy.
Absent subscriber
Message aborted
No end of message or end of transmission received
Out or order
Element of Service not subscribed (e-mail)
Format error
Invalid answerback
Inconsistent request (e-mail)
Call the network information service
Invalid call
Awaiting delivery
Maximum message length exceeded
Local procedure error
Access barred
Network congestion
Subscriber’s number has changed
Not obtainable
Reverse charging acceptance not subscribed
Recipient improperly specified (e-mail)
Redirected call
Remote procedure error
Retransmission still being attempted
Message sent to LES.
Maximum number of addresses exceeded
Unknown status (for example when the Logical chan-
nel number is zero)
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How to manually request delivery status

You can manually request an LES for delivery status of a message you have sent with-

in the past 24 hours.

1. Press the F3 and 3 keys to show the [Request Delivery Status] list. If there are no 

messages in the list, "No message" appears.

2. Select a file then press the Enter key.

3. [Yes] is selected in the [Start] window; press the Enter key to request status. If 

request was successful the message "Successful Deliver Status Request." ap-

pears.

4. Long-press the Esc key to return to the standby display.

Several minutes later the message "Delivery status received for (file name)" appears 

on the display. The reply from the LES appears in the [Delivery] column of the [Re-

quest Delivery Status] list. 

Request Delivery Status

No.

01

02

Message File

ABC

edit msg.002

Station

FURUNO

FURUNO

LES

KDDI

KDDI

Priority

Normal

Normal

Send Status

11-11-25          16:10

Delivery

Request Delivery Status

No.

01

02

Message File

ABC

edit msg.002

Station

FURUNO

FURUNO

LES

KDDI

KDDI

Priority

Normal

Normal

Send Status

11-11-25          16:10

Delivery

Start

NoYes
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5.1.6 How to access the 2-digit code service

A range of special safety and general maritime services, known as the 2-digit code 

services, may be sent. The list below shows the 2-digit code services available. 

1. Use the text editor to prepare a message requesting a 2-digit code service.

2. Press the F3 and 1 keys to display the [Transmit Message] menu.

3. Select [Destination Type] then press the Enter key.

4. Select [Special] then press the Enter key.

5. Select [Destination] then press the Enter key.

6. Enter 2-digit code referring to the table below then press the Enter key.

7. Select [LES ID] then press the Enter key.

8. Select [LES ID] then press the Enter key.

Code Content Remarks

31 Maritime enquiries Request information including ser-
vice offerings.

32 Medical advice Request medical advice.

33 Technical assistance Address technical enquiries to ap-
propriate personnel.

37 Time and charges requested at end 
of call

Desirable for mobile operator when 
sending traffic for a third party. 

38 Medical assistance Request medical assistance.

39 Maritime assistance Request maritime search and res-
cue assistance 

41 Meteorological report Necessary for ease of addressing 
weather reports from ship to meteo-
rological centers.

42 Navigational hazards and warnings Make urgent navigational meteoro-
logical danger reports.

43 Ship position reports Route messages to ship safety re-
porting systems. 

1. Transmit Message

2. Cancel

3. Request Delivery Status

Transmit Message

Normal

                                                Size                   24

  TELEX/MES                                 

  82

  65-2111

 303 (KDDI)

 ON

 00:00

 Immediate

 IA5

    

Priority

Message File

Station Name                                                                

Destination Type

Prefix Code

Country/Ocean Code

    Destination

Modem Type

Address

Subject

Attach File

LES ID

Option

     Confirmation 

     Send Delay 

     Delivery Delay

     Code

[   TRANSMIT   ]



5.  INMARSAT COMMUNICATIONS

5-14

9. Select [TRANSMIT] then press the Enter key.

10. Press the Enter key to send the message.

Note: If some data is missing the message "Input error.xx" (xx: error) is displayed.

11. Long-press the Esc key to return to the standby display.

The message "Current State: SENDING" appears at the bottom of the screen during 

transmission. If the message was sent successfully "Successful Sending message" 

appears and the message is printed ([Confirmation] is turned ON). You can see the 

contents on the [Display Log]. 

At present, not all LESs are offering the 2-digit code services. Contact the LES Oper-

ations Coordinator directly for information.

Some 2-digit code services may be provided free of charge by LESs, while other ser-

vices are available for a fee, in some cases at reduced rates. For information, contact 

the LES directly.

5.1.7 Sent message log

The [Sent Message] log stores all messages sent. You can view the contents of the 

log as shown below.

1. Press the F6 and 1 keys to show the [Sent Message] log.

2. Select a file then press the Enter key to show file contents.

3. Long-press the Esc key to return to the standby display.

Sent Message

Delivery

OCC(002)

Complete

Message File

ABC

DEF

GHI

JKL

MNO

No.

01

02

03

04

05

Destination

FURUNO

FURUNO

ASDFASDF

ABCDEFGH

LES

KDDI

KDDI

KDDI

KDDI

KDDI

Priority

Normal

Normal

Normal

Normal

Normal

Send Status

Waiting

Sending

11-11-26    9:40

11-11-25  20:16  Sent

11-11-23  16:09

[ENTER]: Show Detail

[Ctrl]+[E]: Export         [Ctrl]+[P]: Print          [Delete]: Delete

Number assigned by LES

Text

Destination  : 870773999113
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5.2 Receiving

5.2.1 When a message is received

Each time the FELCOM receives a telex or e-mail it displays the message "Successful 

Receiving message." If [Auto Receive Message Save] and [Auto Receive Message 

Print] (in the [Auto Mode Setup] menu) are set for ON, the message is automatically 

saved and printed (except confidential and password-affixed messages).

Received message alarm

If [Receive Alarm] in the [Auto Mode Setup] menu is set for ON, the audio alarm 

sounds when a telex or e-mail is received. You may silence the alarm with the F10 key.

Receive message format

Each message received is assigned a message number. This number is also used 

when saving the file to the hard disk.

Log

The [Communication Log] (see section 5.3) shows message number, priority, date 

and time of reception, LES ID and file size (in bytes) of the latest 50 received and sent 

messages.

Printing

When [Auto Receive Message Print] in the [Auto Mode Setup] menu is set for ON, re-

ceived messages (except confidential and password-affixed messages) are automat-

ically printed. Manual printing is also available. 

Saving and filing

Received messages are filed in the [Display Message List], at the terminal unit spec-

ified with [Message Output Port] on the [System Setup] menu. The [Display Message 

List] shows the following: 

• Received message no.
• LES ID
• Priority
• File size (in bytes)
• Message classification
• Password for confidential messages
• Date and time of reception
• Status

R

Receive

0

0: main DTE

1: ext. DTE

1    1

year

1    2

month

2    5.

day

0    0    1

receive

message no.
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5.2.2 How to set the receive alarm

You can get an audio alarm when a telex message 

or e-mail is received. The default setting is OFF.

1. Press the F8 and 5 keys to show the [Auto Mode 

Setup] menu.

2. Select [Receive Alarm] then press the Enter 

key.

3. Select [ON] to get the audio alarm when a telex 

message or e-mail is received then press the Enter key.

4. Long-press the Esc key to return to the standby display.

5.2.3 How to display and print received messages

Received messages (except confidential or password affixed) are automatically print-

ed when [Auto Receive Message Print] in the [Auto Mode Setup] menu is turned on. 

To print confidential or password-affixed messages follow the procedure below.

If you cannot read an e-mail attachment, because it is MIME-coded, go to 

section 4.10.

1. Press the F6 and 2 keys to display the [Received Message] log.

Contents of Received Message Log

2. Select a file. To see part of a file selected, tap the Spacebar. Press the Esc key 

after confirming contents.

Item Description Item Description

Message
No.

Received message no. Addressee Addressee code appears 
for confidential messages. 
Nothing appears for routine 
message.

LES LES name Rec date & 
Time

Date and time message 
was received.

Priority Normal Status Printed, message printed; 
Saved, message saved to 
the hard disk, No display, 
not yet printed confidential 
message or printer error.

Size Size of file in bytes Memory 
available

Memory available in termi-
nal unit.

Auto Communication Log Print OFF

Receive Alarm OFF

Auto Receive Message Save OFF

Auto Receive Message Print OFF

Data Report & Polling Print OFF

Auto EGC Message Save

Auto EGC Message Print 

Auto Mode Setup 

Message No.

R0971106.001

R0971105.002

R0971105.001

R0971101.001

R0971024.001

LES

KDDI

KDDI

KDDI

KDDI

KDDI

Priority

Normal

Normal

Distress

Normal

Normal

Addressee

CAPTAIN

OFFICER

Rec date & time

02-02-04 16:10

02-02-05 17:30

02-02-05 14:15

02-02-01   3:45

02-01-24 13:20

Status

Saved

Printed

Printed

Printed

Saved

Memory Available: 3317 Bytes

Size

32767

200

1234

3256

8251

Received Message 

[ENTER]: Show Detail

[Ctrl]+[E]: Export         [Ctrl]+[P]: Print          [Delete]: Delete



5.  INMARSAT COMMUNICATIONS

5-17

3. Press the Enter key for routine messages and messages with addressee code 

(no password).

For messages with both addressee code and password, the password entry win-

dow appears. Enter the password and then press the Enter key. If the password 

is entered incorrectly, the buzzer sounds. Reenter the password. 

4. To print a message, press the P key while pressing the Ctrl key.

5. Long-press the Esc key to return to the standby display.

Received Message Detail

FROM FURUNO

TO FRONTIER

THE QUICK BROWN FOX JUMPS OVER LAZY DOG.

ABCDEFGHIJKLMNOPQRSTUVWXYZ. 1234567890

[Ctrl]+[E]: Export  [Ctrl]+[P]: Print  [Ctrl]+[R]: Reply  

Received Message

Message No.

R0021106.001

R0021105.002

R0021105.001

R0021101.001

R0021024.001

LES

KDDI

KDDI

KDDI

KDDI

KDDI

Priority

Normal

Normal

Distress

Normal

Normal

Addressee

CAPTAIN

OFFICER

Rec date & time

02-11-06 16:10

02-11-05 17:30

02-11-05 14:15

02-11-01   3:45

02-10-24 13:20

Status

Saved

Printed

Printed

Printed

Saved

Memory Available: 3317 Bytes

Size

32767

200

1234

3256

8251

[ENTER]: Show Detail

[Ctrl]+[E]: Export         [Ctrl]+[P]: Print          [Delete]: Delete

PASS WORD:  

Received Message (SECRET)

Message No.

Message Ref. No.

LES

Priority

Message Size

Receive Date & Time

abcdefghijklmnopqrstuvwxyz........

: R0970323.001

: 00000000

: LES or LES ID

: Normal (or Distress)

: 205 characters

: 02-02-25

Appears only for confidential 

messages

Text
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About attachments

The FELCOM receives a file with an attachment over a landline two ways. (The meth-

od depends on LES.) 

• Mail main text and text mail which includes information about the attachment.

•  Attachment data

Some files stored on the [Received Message] log may not be readable. Choose the 

file and press the Enter key. If the file is unreadable, because it is in a language other 

than English (for example, Japanese). Press the S key to save the file to the hard disk. 

Open the file with a different application.

5.2.4 How to automatically print received messages

You can automatically print received messages (except confidential and password-af-

fixed messages).

1. Press the F8 and 5 keys to show the [Auto Mode 

Setup] menu.

2. Select [Auto Receive Message Print] then press 

the Enter key.

3. Select [ON] to automatically print received mes-

sages then press the Enter key.

4. Long-press the Esc key to return to the standby 

display.

Received Message

Message No.

R0021105.002

R0021105.001

R0021104.001

R0021101.001

R0021024.001

LES

KDDI

KDDIDDI

KDDI

KDDI

KDDI

Priority

Normal

Normal

Distress

Normal

Normal

Addressee

OFFICER

Rec date & time

02-11-05 17:40

02-11-05 17:30

02-11-04 14:15

02-11-01   3:45

02-10-24 13:20

Status

Printed

Printed

Printed

Printed

Saved

Memory Available: 3317 Bytes

Size

18

210

1234

3256

8251

[ENTER]: Show Detail

[Ctrl]+[E]: Export         [Ctrl]+[P]: Print          [Delete]: Delete

Mail and attachment file data

Attachment data

One attachment
Received Message Detail

FROM : FURUNO

TO: FRONTIER

1 attachment

18 bytes, test

Text

[Ctrl]+[E]: Export     [Ctrl]+[P]: Print    [Ctrl]+[R]: Reply

Attachment name

Auto Communication Log Print OFF

Receive Alarm OFF

Auto Receive Message Save OFF

Auto Receive Message Print OFF

Data Report & Polling Print OFF

Auto EGC Message Save

Auto EGC Message Print 

Auto Mode Setup 
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5.2.5 How to save received messages 

1. Press the F6 and 2 keys to display the [Received Message] log.

2. Select the file to save. To confirm contents of a file, press the Enter key. For con-

fidential messages the password entry window appears after pressing the Enter 

key. Enter the password then press the Enter key.

3. Press the S key to save the file. For confidential messages the password entry 

window appears. Enter password then press the Enter key.

If the same file name is found on the hard disk, "File already exists. Overwrite?" ap-

pears.

5.2.6 How to automatically save received message

1. Press the F8 and 5 keys to show the [Auto Mode Setup] menu.

2. Select [Auto Receive Message Save] then press the Enter key.

3. Select [ON] to automatically save received messages then press the Enter key.

4. Long-press the Esc key to return to the standby display.

5.2.7 How to delete received messages

1. Press the F6 and 2 keys to display the [Received Message Log].

2. Select the file to delete. To confirm contents of a file, press the Enter key. For 

password-affixed messages the password entry window appears. Enter the pass-

word then press the Enter key.

3. Press the Delete key. You are asked if you are sure to delete the message file. 

For password-affixed messages, the password entry screen appears. Enter pass-

word then press the Enter key.

4. Press the Enter key to delete the message, or select No then press the Enter key 

to escape. 

5. Long-press the Esc key to return to the standby display.
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5.3 Communication Log

The [Communication Log] stores the particulars of the latest 50 received and sent 

messages. When the log becomes full, the oldest message is automatically deleted. 

5.3.1 How to display and print the communication log

1. Press the F6 and 4 keys to display the [Communication Log].

2. To scroll the log, use the ↓ key.

3. To print the log, press the P key while pressing and holding down the Ctrl key. To 

stop printing, press the Esc key.

Communication Log description

5.3.2 How to automatically print the communication log

1. Press the F8 and 5 keys to show the [Auto Mode Setup] menu.

2. Select [Auto Communication Log Print] then press the Enter key.

3. Select [ON] to automatically print the log then press the Enter key.

4. Long-press the Esc key to return to the standby display.

001 -:
S/R:
Cate:
Type:
Ch:
Ch-Num:
Pri:
LES
Size:
St:
Op. TIme:
Date & Time:

Log no.
S: Sent message, R: Received message
Category (MSG, EGC, DR, EDR, PADR, EPADR, POLL)
Message type (Telex, e-mail, etc.) 
Channel type (TDM, SIG, etc.)
5-digit channel number
Normal
ID of LES that handled the message
Size of message (in Bytes)
Communication results. S, Success; F, Failed
Total operating time (in sec) since commissioning
Date and time the message was sent.

Communication Log

No.  S/R Cate      Type Ch    Ch-Num Pri  LES  Size  St   Op. Time        Date & Time

001 S MSG TLX MSG 11100    Dis  322 10     S    0031104000 Dec-25-2011 17:46
002 R POLL DND TDM 11200  322 10       0031104061 Dec-25-2011 17:44
003 S DR DND SIG 11300  322 10     S    0031104122 Dec-25-2011 17:43
004
005
006
007
008
009
010

[Ctrl]+[P]: Print

- - - - - - - - - - - -  - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

- - - - - - - - - - - -  - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 

- - - - - - - - - - - -  - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - - 
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5.4 EGC Messages

When an EGC message is received, "RECEIVING EGC MESSAGE" appears at the 

bottom left corner of the display. If "Auto EGC Message Print" in the [Auto Mode Set-

up] menu is ON, EGC messages are automatically printed. EGC messages are auto-

matically received, printed and saved to the terminal unit selected with [EGC Output 

Port] on the [System Setup] menu. The memory capacity for EGC messages is 32 Ki-

lobytes. When the EGC message memory becomes full, the oldest EGC message is 

automatically deleted.

EGC messages can be automatically saved to the hard disk. See section 3.4.4 for de-

tails.

5.4.1 How to display and reprint EGC messages

1. Press the F4 and 1 keys to show the [Display EGC Message] screen.

2. Use the ↑ and ↓ keys to scroll the screen.

3. To print a message, press the P key while pressing and holding down the Ctrl key. 

4. Long-press the Esc key to return to the standby display.

 EGC messages can be automatically saved to the hard disk. See section 3.4.4 for de-

tails.

5.4.2 How to display EGC closed network ID (ENID)

To join a FleetNET service, an MES must be registered with an information provider. 

The information provider adds the MES to the group which is to receive the service, 

by downloading a Group Call ID (via an LES which supports FleetNET broadcasts), 

uniquely addressed to the MES. The MES stores the ID and can accept broadcasts 

from the information provider. The MES operator cannot change this stored EGC 

closed network IDs (ENIDs). Up to 64 ENIDs are stored on a non-volatile memory. 

The ENID stored can be accessed for downloading and deleting via the satellite path. 

An MES operator can inhibit (or activate as required), via the terminal unit, selected 

ENIDs previously downloaded.

Along with the ENID the name of the information provider is stored. In the event that 

a download command is received and the ENID storage area is full, an ENID which 

: 00472

: KDDI

: Urgent

: 285 characters

: 02-11-02  06:08  (UTC)

EGC Message Detail 

EGC Message  --- MET Navarea Warning or MET Forecast ---

Message Sequence No  

LES

Priority

Size

Receive Date & Time

ZCZC

NAVAREA XI WARNING

NAVAREA XI  0752.

ARAFURA SEA.

DERELICT F/V PARTIALLY SUBMERGED ADRIFT

IN 10-12.6S 133-19.6E, GEODETIC DATUM

UNKNOWN, AT 180200Z NOV.

CANCEL 0749/02.

Ctrl+P : Print        [   Ctrl+S: Save                  
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has been disabled by the MES operator will be written over. If none has been disabled, 

then the new download is not accepted. 

Follow the procedure below to enable or disable an ENID.

1. Press the F4 and 2 keys to show the [EGC Network ID] screen.

2. Select the ENID to inhibit or activate.

3. Press the Enter key to enable or disable the ENID as appropriate. Enabled ENIDs 

show an asterisk (*).

4. Long-press the Esc key to return to the standby display.

5.4.3 How to display the EGC message log

1. Press the F6 and 3 keys to show the [EGC Message] log.

Scroll: ↑, ↓

Display message: Press the Enter key.

Save message: Press the S key.

Delete message: Press the D key to show the Delete window. [Yes] is selected; 

press the Enter key.

2. Long-press the Esc key to return to the standby display.

                                                                           Ctrl+P: Print 

Mark '*' means activation.

01

02

03

04

05

*

*

* 

*

*

11111

22222

33333

44444

55555

EGC Network ID List

EGC Message

Message No.      LES                  Priority     Size   Seq. No.  Rec date&Time  Type

E0021118.028    KDDI                 Urgent       428     01641        11-11-25   10:27    MET/NAV

E0021118.028    KDDI                  Safety       428     02035        11-11-11   05:21    U.M Rct

                                                                                       Memory available: 32767 Bytes

_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ 

[ENTER]: Show Detail

[Ctrl]+[E]: Export         [Ctrl]+[P]: Print          [Delete]: Delete
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6. DATA REPORT AND POLLING

This chapter provides the information necessary for data reporting and polling recep-

tion. Data reporting provides automatic data transmission at regular intervals from 

your ship to your home office. When your ship receives a polling command from your 

home office; that is, a request for navigation data from your ship, it automatically trans-

mits this data to your home office. 

No operator intervention is required during polling reception. 

6.1 Data Reporting

Data reporting provides automatic data transmission at predetermined intervals from 

your ship to your home office. The data are position, speed, bearing and other data 

sent from a navigator or an interface unit.

The data transmitted from the FELCOM is temporarily stored in a data reporting file at 

the LES. When an operator at your home office accesses the LES, the LES delivers 

the data to your home office. Some LESs may deliver it without being accessed.

Data reporting can be initiated by setting a data report on the FELCOM or receiving a 

polling command from your home office. 

This FELCOM offers two types of reports: 

• Data report (on MES signaling channel). See section 6.1.1.

• Message report (on MES message channel). See section 6.1.2.

Data report

Message report
Polling

Satellite

Mobile Earth Station Land Earth Station Subscriber
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6.1.1 How to prepare a data report

1. Press the F5 and 1 keys to show the [Data Report] menu.

2. Press the appropriate numeric key to select a data report.

3. [Status] is selected; press the Enter key to open the status options window.

4. Select appropriate option then press the Enter key.

OFF: Data report off

ON: Enhanced Data Report (Data report w/confirmation)

ON: Usual Data Report (Standard data report)

For assured transmission, select ON: Enhanced Data Report.

5. Select [Report Length] then press the Enter key.

6. Select appropriate option then press the Enter key.

Position only: Own position

Position and Course/Speed: Position, course and speed

Position and Course/Speed with SEA INF: Position, course, speed, water tem-

perature, tide, and depth 

7. Select [DNID] then press the Enter key.

8. Select DNID desired then press the Enter key. (LES ID and Member No. are au-

tomatically selected according to DNID.) 

9. Select [Activation] then press the Enter key.

10. Select [Regular Interval] or [Daily] as appropriate then press the Enter key.

11. Do one of the following depending on selection made at step 10.

[Regular Interval] selected at step 10

1) Select [Interval Time] then press the Enter key.

2) Key in interval time then press the Enter key.

3) Select [Report Times] then press the Enter key.

4) Key in the report times, or press the BackSpace key to display “---” to select 

[No Limit] to transmit data until the Status setting is turned OFF. Press the En-

ter key. 

5) Press the Enter key to close the window.

[Daily] selected at step 10

1) Select [Start Time 1] then press the Enter key.

2) Key in the start time, in 24-hour notation, then press the Enter key.

3) If necessary, key in the start times 2-4.

12. Press the Esc key to show the [Update] window.

Data Report

1. Data Report 1

2. Data Report 2

3. Data Report 3

4. Data Report 4
Data Report

OFF

Position and Course/Speed

Regular Interval

00:10

1   (- - - : No Limit)

Data Report Programming

Status

Report Length

Destination

DNID

LES ID

Member No.

Activation

Interval Time

Report Times

Start Time1        - - : - -

Start Time2        - - : - -

Start Time3        - - : - -

Start Time4        - - : - -
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13. [Yes] is selected; press the Enter key to register the settings.

14. Long-press the Esc key to return to the standby display.

6.1.2 How to prepare a message report

1. Press the F5 and 2 keys to show the [Message Report] menu.

2. Press the appropriate numeric key to select a message re-

port.

PIN code is unrelated to message reporting, however it is necessary for polling 

(see section 6.2). Enter PIN code as shown below. 

3. [PIN Code] is selected; press the Enter key to open the PIN code entry window.

4. Key in PIN code, using up to eight digits, then press the Enter key. The PIN code 

is a password used in message reports. When a ship receives a polling command 

w/PIN code from a shore subscriber and the code matches that of the ship, the 

ship sends a message report. 

5. Select [Status] then press the Enter key.

6. Turn the message report ON or OFF as appropriate then press the Enter key.

7. Select [Station Name] then press the Enter key.

8. Select the station name then press the Enter key.

You may sort the list by group name, station name or communication type as fol-

lows:

Group name: Each press of Ctrl+G sorts the list by group name, ascending or 

descending order.

Station name: Each press of Ctrl+N sorts the list by station name, in ascending 

or descending order.

Comm. type: Each press of Ctrl+T sorts the list by communication type, in as-

cending or descending order. 

9.  For e-mail do step 1) and 2) below. For other communication formats, go to step 

10. 

1) Select [Subject] then press the Enter key. 

2) Key in the subject then press the Enter key. 

Mesasge Report

1. Message Report 1

2. Message Report 2

3. Message Report 3

4. Message Report 4
Message Report

OFF

TELEX

Regular Interval

00:10

1   (- - - : No Limit)

- - : - -

- - : - -

- - : - -

- - : - -

NAV

PIN Code

Message Report Programming

Status

Station Name

Destination Type

Prefix Code

Country/Ocean Code

Station ID

Modem Type

Address

Subject

LES ID

Activation

Interval Time

Report Times

Start Time1

Start Time2

Start Time3

Start Time4

Report Contents

   File
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10. Select [LES ID] then press the Enter key.

11. Select LES then press the Enter key.

12. Select [Activation] then press the Enter key.

13. Select [Regular Interval] or [Daily] as appropriate then press the Enter key.

14. Do one of the following depending on selection made at step 13.

[Regular Interval] selected at step 13

1) Select [Interval Time] then press the Enter key.

2) Key in interval time then press the Enter key.

3) Select [Report Times] then press the Enter key.

4) Key in the report times, or press the BackSpace key to display “---” to select 

[No Limit] to transmit data until the Status setting is turned OFF. Press the En-

ter key. 

[Daily] selected at step 13

1) Select [Start Time 1] then press the Enter key.

2) Key in the start time, in 24-hour notation, then press the Enter key.

3) If necessary, key in the start times 2-4.

15. Select [Report Contents] then press the Enter key.

16. Select required report contents then press the Enter key.

NAV: Position, speed, course

NAV(R): Position, speed, course. The difference between this and [NAV] above 

is that blank areas in data are shortened to lessen toll charge.

FILE: Select a file. (When selected [FILE] is activated, Select the file then press 

the Enter key.)

17. Press the Esc key to show the [Update] window.

18. [Yes] is selected; press the Enter key.

19. Long-press the Esc key to return to the standby display.

6.1.3 How to automatically print data report, polling command

1. Press the F8 and 5 keys to show the [Auto Mode 

Setup] menu.

2. Select [Data Report & Polling Print] then press 

the Enter key.

3. Select [ON] to automatically print data reports 

and polling commands then press the Enter key.

4. Long-press the Esc key to return to the standby 

display.

Auto Communication Log Print OFF

Receive Alarm OFF

Auto Receive Message Save OFF

Auto Receive Message Print OFF

Data Report & Polling Print OFF

Auto EGC Message Save

Auto EGC Message Print 

Auto Mode Setup 
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6.2 Polling

When the FELCOM receives a polling command from your home office it automatically 

transmits data to your home office. The data are position, speed, bearing and other 

data sent from a navigator or an interface unit. 

A polling command from your home office can also activate a data report or message 

report if the corresponding setting is completed on the FELCOM. If a polling command 

with a file name is received, the FELCOM transmits the file to your home office. 

6.2.1 Polling commands

This section shows you how to make the polling command at your home office.

There are two kinds of polling commands: one is sent on the MES signalling channel 

and the other is sent on the MES message channel. 

Polling command on the MES signalling channel

Request a land station to make the polling command because the format varies with 

land station. 

Polling command on the MES message channel

To make the polling command, enter D???, hyphen, PIN code (max. 8 digits), hyphen, 

file name, colon.

To send file data, type a hyphen and file name. Then, only the file specified in the di-

rectory of the Message Directory is transmitted. If neither hyphen nor file name is en-

tered, nav data (own ship position, course, speed, etc.) is transmitted.

How to register your PIN code

The PIN (Personal ID Number) code is a password used in message reporting, and is 

an eight-digit number agreed upon by communicating parties. There is no rule for de-

termining PIN code. When a ship receives a polling command w/PIN code from a 

shore subscriber and the code matches that of the ship, the ship sends a message 

report. 

1. Press the F5 and 2 keys to show the [Message Report] menu.

2. Press the 1, 2, 3 or 4 key to select a message report and show the following menu.

3. [PIN Code] is selected; press the Enter key to open the PIN code entry window.

4. Enter PIN code number (max. 8 digits) then press the Enter key. 

5. Follow the procedure from step 5 on page 6-3.

D???-XXXXXXXX-TEST: 

PIN Code

File Name

Message Report

OFF

PIN Code

Message Report Programming

Status

Station Name
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6.2.2 Other polling commands

Telex: P???/PIN Code/TELEX/LES number/Country number/Sub-
scriber’s number/File name:

E-mail: P???/PIN Code/EMAIL/LES number/ E-mail address/File 
name:

Public Switched
Telephone Network:

P???/PIN Code/PSTN/Modem type/LES number/Country 
number/Subscriber’s number/File name:

Modem type is selected from T30, V21, V22B, V22, V23, 
V26B, V26T, V27T or V32.

Packet Switched
Data Network:

 P???/PIN Code/PSDN/LES number/Country number/Sub-
scriber’s number/File name:

Data Network
Identification:

P???/PIN Code/DNID/LES number/Subscriber’s number/File 
name: 

Facsimile: P???/PIN Code/FAX/LES number/Country number/Subscrib-
er’s number/File name: 

2-digit telex
service:

P???/PIN Code/SPEC/LES number/Country number/Sub-
scriber’s number/File name:

For ship-to-ship communication, country number is ocean re-
gion number. Subscriber’s number includes Station ID, Telex 
ID, etc. If file name is not specified (/:), position, speed, bear-
ing, water temperature, current and depth are transmitted. Fur-
thermore, / is deleted (:), position, speed and bearing are 
transmitted.

For example, you transmit polling command to MES of PIN 
code 12345678 via KDDI station (Pacific Ocean: 203) specify-
ing telex number 720-5644325. Then, that MES transmits po-
sition, speed, bearing, water temperature, current and depth.

P???/12345678/TELEX/203/720/5644325/:
To have other MES transmit position, speed and bearing by e-
mail to abc@furuno.co.jp, for example, use the following com-
mand.

P???/12345678/EMAIL/203/abc@furuno.co.jp: 



6.  DATA REPORT AND POLLING

6-7

6.2.3 Polling reception

No operator intervention is required during polling reception. 

The printer (printer PP-510, optionally available) prints the status of polling reception 

and transmits data in response to polling request as shown below. 

POLLING Message    - - - Program Unreserved Data Reporting - - -

DNID            : 0004      LES ID                 : 101  (Telnor S.S.Inc)

Sub Address  : 000        Member Number  : 001  Response: No Response

Receive Data & Time: 02-02-25  00:01 (UTC)

Start Frame: 00030        Interval: 00030

02-02-25  00:01 (UTC)

Data Report Program has been initiated by Polling.

POLLING Message    - - - Initiate Unreserved Data Reporting - - -

DNID            :0004       LES ID                 :101  (Telnor S.S.Inc)

Sub Address  : 000        Member Number  :001  Response: Data Report

Receive Data & Time: 02-02-25 00:01 (UTC)

Start Frame: 00030        Interval: 00030

Data Reported (Poll Response)

LES               :Telnor S.S.Inc       Date       : 02-02-25

DNID            :00004                    Time       : 00:03 (UTC)

Member No.  :001

Position          LAT      10:14.03N

                       LON   124:36.81E

02-02-25  00:06 (UTC)

Successful Data Report Sending.

Data reportingTX start frame (time)

TX interval

TX data set on Data 

Report

Receive Message

Message No. : R0020205.002

Message Ref. No. : 00616923

LES  : KDDI

Priority  : Normal

Message Size :      121 characters

Receive Data & Time : 02-02-25  04:07 (UTC)

KDD INMARSAT-C SERVICE   25-FEB-02 04:02:28 UTC REF:616923

XXXXXXXXX ABCD X via KDDI LES

D???-12345678-test:test

02-02-25  04:09 (UTC)

Successful Sending message.

Sent Message

 DELIVERY CONFIRMATION OFF

 Message File : Report Message Size:    284 characters

 LES : KDDI Date : 02-02-25

 Priority : Normal Time : 04:09 (UTC)

 Destination : TELEX                 582 (IA5)

 582+

 Date & Time 02-02-25   04:07 (UTC)

 Position LAT    12:34.56N Water Temp      32.1

  LON  123:45.67E Water Current       22.3 kn

 Course 321.1      111.0

 Speed     1.1 kn Depth    123.4FT

Tx message

recipient and

TX data

Tx message

recipient and

TX data

Received

Polling

Command

Received

Polling

Command
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6.3 DNID (Data Network Identification)

When you make a contract with an information provider, DNIDs are downloaded from 

the information provider to the FELCOM, via the appropriate LES.

Up to 64 DNIDs can be downloaded to the FELCOM. You can see which DNIDs are 

stored by following the procedure shown below. 

6.3.1 How to display DNIDs

You need to make a contract with an LES to exchange data within a group. The LES 

sends a DNID (Data Network Identification) number to each member of the group. The 

FELCOM can store a maximum of 64 DNIDs. 

1. Press the F5 and 4 keys to show the [Data Network ID] list.

“Act” indications and their meanings 

Asterisk: Enabled DNID

No indication means disabled DNID.

24h: Enabled DNID. TX cycle changes every 24 hours.

STP: Enabled DNID. TX temporarily disabled.

6.3.2 How to enable, disable DNIDs

A DNID can be enabled or disabled as follows:

1. Press the F5 and 4 keys to show the [Data Network ID] list.

2. Select the DNID to process then press the Enter key. A password input screen 

appears. Enter the password provided by the LES. The screen shown below ap-

pears. (If the password is wrong, the password input screen closes.)

3. Select applicable item then press the Enter key.

Disable: DNID disabled Enable: DNID Enabled

Enable (24-hour): DNID enabled (TX cycle changes every 24 hours.)

Enable (Temporary Stop): DNID enabled (TX temporarily stopped)

4. The [Update] window appears. [Yes] is selected; press the Enter key.

Data Network ID

Mark '*' means activation.                                                            Ctrl+P: Print 

No.

01

02

03

04

05

06

07

08

Act

*

24h

STP

*

24h

 STP

DNID

01000

01001

01002

01003

01004

01005

01006

01007

LES

002

001

102

131

202

210

302

304

Subaddr

000

001

002

003

004

000

001

002

Member

235

085

215

033

227

013

079

089

Text

Sub address Member number using DNID

Disable

Enable

Enable (24-hour)

Enable (Temporary Stop)
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6.4 EPADR (Enhanced Pre-Assigned Data Report-
ing)

EPADR increases the efficiency of maritime data reporting, allowing vessels using 

satellite services to reliably send position reports and comply with the International 

Maritime Organization's (IMO) new Long Range Identification and Tracking (LRIT) 

regulations.

6.4.1 How to prepare a data report

1. Press the F5 and 3 keys to show the [EPADR] menu.

2. Press the appropriate numeric key to select a data report. For example, press the 

1 key to select [EPADR 1].

3. [Status] is selected; press the Enter key to open the status options window.

4. Select appropriate option then press the Enter key.

OFF: Data report off

ON: Data report on

5. Select [Report Length] then press the Enter key.

6. Select appropriate option then press the Enter key.

Position only: Own position

Position and Course/Speed: Position, course and speed

Position and Course/Speed and SEA INF: Position, course, speed, water tem-

perature, tide, and depth 

7. Select [DNID] then press the Enter key.

8. Select DNID desired then press the Enter key. (LES ID and Member No. are au-

tomatically selected according to DNID.) 

9. Select [Interval Time] then press the Enter key.

10. Select an interval (15 min, 30 min, 1 hr, 3 hrs, 4 hrs, 6 hrs, 8 hrs) then press the 

Enter key.

11. Select [Report Times] then press the Enter key.

12. Enter the number of times to transmit then press the Enter key. (Data is transmit-

ted only the number of times specified.)

EPADR1

Status                 ON

Report Length Position and Course/Speed

Destination

  DNID  21100

  LES ID  203

  Member No. 020

Activation  Regular Interval

   Interval Time 1 hour

   Report Times 600

   Requested by LES

Enhanced Pre-Assigned Data Report (EPADR) Programming
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6.5 LRIT Overview

6.5.1 LRIT overview

This equipment can function as a marine communications terminal for the LRIT (Long-

Range Identification and Tracking) system, as prescribed by the IMO resolution 

MSC.202(81). The LRIT uses the FELCOM's Data Report/Polling feature for LRIT po-

sition reporting.

The LRIT system is fully automatic, thus no operation is required of the user. However, 

follow the guidelines shown below to use this equipment as an LRIT device. 

The data listed below is sent by the FELCOM when it receives a command from the 

LRIT data center.

• ID number of this equipment

• Position of your ship

• Time of position

The FELCOM sends data at intervals between 15 minutes and 6 hours. 

The FELCOM automatically receives commands (related to time of position reporting, 

transmission interval) from the LRIT data center. To receive the commands at all 

times, keep the equipment powered and logged in. 

Satellite System

LRIT DATA

CENTER

Country A

Country B

Country C

Coast Station
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6.5.2 About the LRIT system

 Power the equipment and keep it logged in at all times except for special occasions 

such as when the ship is dry-docked for repairs. Position information is automati-

cally sent at fixed intervals, thus no operation is required. However, keep the equip-

ment in a ready state to received commands from the LRIT data center. Combined 

use for routine messages, distress messages and SSAS (Ship Security Alert Sys-

tem) is possible.

The source of position data for this equipment can be its internal GPS receiver or 

external GNSS (Global Navigation Satellite System) equipment. For GNSS equip-

ment, interface directly to the shipborne global navigation satellite system equip-

ment. 

If external GPS equipment is used, set it to use WGS84 datum. Further, the output 

sentences should minimally be as follows:

• Time data input: ZDA 

• Position data input: RMC or GGA and VTG (pair)

This equipment and external GNSS equipment must be powered in the following 

manner. 

•  If the above equipment is used as a GMDSS device also, connect them to an 

auxiliary power source (radio communications battery).

• If the above equipment is not used as a GMDSS device, connect them to both 

main and emergency power sources (via AC/DC Power Supply Unit PR-240).

If an error message appears, take the necessary measures to restore normal op-

eration as soon as possible. Shown below are representative alarms. 

•  "WARNING: External NAV equipment failure." Position data is not input from 

the external GNSS equipment. Check the GNSS equipment and the wiring be-

tween the GNSS and the FELCOM.

•  "WARNING: Internal GPS UNIT failure." Position data is not input from the in-

ternal GPS receiver. If this alarm occurs frequently, have the set checked.

• "WARNING: Synchronization loss." Check the current Ocean Region.

• "WARNING: BBER over 80%. Scanning NCS start manually." Problem with 

receiving the Inmarsat-C signal. Check if the current sea area is suitable for your 

position. If it is not, change the sea area. If the area is suitable and the alarm con-

tinues, check the antenna and antenna cable. Request service if the problem 

persists.
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7. OTHER FUNCTIONS

This chapter describes how to

7.1 How to Abort an Operation

You can abort transmission, receiving or scanning (on the NCS common channel) as 

follows:

1. Press the F7 and 4 keys to show the [Options] menu and select [Abort].

2. The [Update] window appears and [Yes] is selected; press the Enter key to abort 

current operation.

The message "FORCED CLEARING" replaces "SENDING" or "RECEIVING" at the 

bottom of the screen. When the process has been aborted, the message "Process 

Aborted. Press any key to escape." appears. 

 If aborting is attempted in modes other than those mentioned above, the message 

"Ignored: Can not abort current process." appears. 

7.2 How to Scan NCS Common Channels

Scanning is possible when the FELCOM is in idle state and functions as an Inmarsat 

C receiver. If the FELCOM is not in idle state, the message "Ignored: MES is not idle." 

appears. Wait until the equipment becomes idle. 

1. Press the F7 and 6 keys to display the [Ocean Region] menu.

2. Select a NCS other than the one you are currently using then press the Enter key. 

[Auto] scans all regions in turn.

3. [Yes] is selected; press the Enter key to start the scanning.

4. Long-press the Esc key twice to return to the standby display.

• Abort operation
• Scan NCS
• Select EGC and NCS channels
• Display LES information

1. Login

2. Logout

3. Abort

4. Select NCS

5. Ocean Region

6. Test

Ocean Region

Auto

West-Atlantic

East-Atlantic

Pacific

Indian

NCS you are currently tuned to 

appears in reverse video.
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7.3 How to Select EGC Receiving Channel

EGC channel can be selected when the terminal unit is set to operate as an EGC-only 

receiver. However, this procedure is shown for reference only; currently there is only 

one EGC channel per NCS. 

1. Press the F7, 5 and 3 keys to display the [EGC Channel List].

2. Select a desired channel then press the Enter key. 

3. Long-press the Esc key to return to the standby display.

7.4 How to Select NCS Channel

You may select NCS common channel as shown below. Currently, each satellite 

sends one global beam. In the future, the satellites will transmit multiple spot beams, 

namely, the NCS will have multiple channels. 

1. Press the F8, 8 and 4 keys to display the [NCS Channel List].

2. Select a desired channel then press the Enter key.

3. Long-press the Esc key to return to the standby display.

35:00.00N

135:00.00E

EGC Channel List

12580* 10840* 11088*

ENTER: Set   ESC: Quit

11080*

NCS Channel List

No AOR (WEST)

FREQ

11080*

ID

044

0

0

0

0

0

0

0

01

02

03

04

05

06

07

08

ENTER: Set   ESC: Quit

AOR (EAST)

FREQ

12580*

ID

144

1

1

1

1

1

1

1

POR

FREQ

12580*

ID

244

2

2

2

2

2

2

2

IOR

FREQ

10840*

ID

344

3

3

3

3

3

3

3
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7.5 How to Find LES Information

Each time you log in LES data is automatically downloaded through the NCS common 

channel to the FELCOM, and saved to the LES Information display. You may view this 

display as follows:

1. Press the F7 and 7 keys to display the [LES Information] screen.

2. Use the ↑ and ↓ keys to scroll the list.

3. Long-press the Esc key twice to return to the standby display.

Description of status

Bit No. Status Flag Meaning

B8 Return link speed 1 600 bps

0 300 bps

B7 Operational or spare 
satellite operation

1 Operational

0 Spare

B6 LES status 1 In service

0 Out of service

B5 LES status 1 Clear 

0 Congested

B4 For LES use 1 Terrestrial links open

0 Terrestrial links closed

B3-1 Spare 1

0

LES ID  Name  Status Services TDM Ch.

201 Telnor S.S.Inc 11111000 AS-----EL 11982

202 Stratos M.N. 11111000 AS-----EL      11826

203 KDDI         11111000 AS-----EL 11806

204 Telnor S.S.AS          11111000     AS-----EL 11762

208  Korea Telecom  11111000 AS-----EL 11778

210 Singapore T.  11111000 AS-----EL 11842

211 Beijing Marine 11111000 AS-----EL 11754

212 Xantic                   11111000 AS-----EL 11802

LES Information

B8-B1
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Description of services

Bit No. Flag Meaning Flag

1B8 1 Maritime distress alerting A

0 No Maritime distress alerting None

1B7 1 SafetyNET traffic S

0 No SafetyNET traffic None

1B6 1 Inmarsat C traffic C

0 No Inmarsat C traffic None

1B5 1 Store and forward T

0 No Store and forward None

1B4 1 Half duplex H

0 No Half duplex None

1B3 1 Full duplex D

0 No Full duplex None

1B2 1 Closed network N

0 No Closed network None

1B1 1 FleetNET traffic F

0 No FleetNET traffic None

2B8 1 Prefixed Store and forward message supported P

0 No Prefixed Store and forward message supported None

2B7 1 Land mobile alerting No use.

0 No Land mobile alerting

2B6 1 Aero-C service supported No use

0 Aero-C service not supported

2B5 1 ITA2 transmission supported I

0 ITA2 transmission not supported None

2B4 1 Data transmission supported B

0 Data transmission not supported None

2B3 1 Basic X400 supported X

0 Basic X400 not supported None

2B2 1 Enhanced X400 supported E

0 Enhanced X400 not supported None

2B1 1 Low power C MES supported L

0 Low power C MES not supported None



8-1

8. MAINTENANCE AND
TROUBLESHOOTING

This chapter provides the information necessary for the maintenance and checking of 

the FELCOM. Please review the safety information at the beginning of this manual be-

fore attempting any maintenance procedures.

8.1 General Checking and Maintenance

Turn off the power before conducting any maintenance procedures other than the 

cleaning of the communication unit.

How to clean the communication unit

Dust and dirt can be removed from the communication unit with a soft, dry cloth. DO 

NOT use chemical cleaners. They may remove paint and markings and deform the 

equipment.

How to check connectors and ground terminal on the communication unit

Check that the connectors and earth terminal on the communication unit are tightly 

fastened. If the copper strap (earth material) has rusted, clean it. 

If the communication unit cannot be turned on...

• Check if the power cable connector on the rear panel of the communication unit is 

tightly fastened.

• Check if the ship’s mains switchboard is turned on.

• If you still cannot turn on the power, have a qualified technician check the power 

voltage at the power connector on the rear of the communication unit.

Antenna unit

Check the antenna unit yearly for rust, corro-

sion and chipped paint. If the antenna base has 

rusted or the paint has chipped, paint the af-

fected area. Paint only the antenna base. Do 

not paint the radome. Paint on the radome can 

cause loss of sensitivity and crack the radome.

IMPORTANT
Do not apply paint, anti-corrosive sealant or 

contact spray to coating or plastic parts.

Those items contain organic solvents that can 
damage coating and plastic parts, especially 
plastic connectors.

Paint this area.

Do not paint this area.
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8.2 Diagnostics

8.2.1 Self test at power on

The communication unit performs the ROM sum test and RAM read and write test at 

power up. If the test results are normal, the equipment goes into standby. If error is 

found you cannot transmit.

8.2.2 Diagnostic test

This communication unit must be in idle state to do the test. 

1. Press the F7 and 8 keys to show the [Test] menu.

2. Press the 3 key to select [Diagnostic Test].

3. The [Start] window appears and [Yes] is selected; press 

the Enter key to start the test.

When the test is completed, the screen shows the test results. 

4. Press the Esc key stop the test and return to the [Test] menu.

(1) Date and time of test

(2) Program version no. PC Terminal

(3) Date and time of most recent TX and RX and the power output and current level 
at that time

(4) Levels of various components. See page 8-5 for description.

(5) Status of equipment connected to the Remote Box

(6) Status of GPS navigator

(7) Results for ROM, RAM and EEPROM check (OK: Normal, NG: No Good)

(8) Program version of CPU in Communication Unit

Test

1. PV Test

2. PV Test Result

3. Diagnostic Test

COMMCPU 1650248-xx*               PC TERMINAL 1650241-xx* 

ROM OK                                  

RAM OK 

EEPROM OK 

GPS State   INT/EXT  2D  OK

FELCOM19 2012/02/02  20:30 (UTC)

Diagnostic Test

Remote Box
1. SSAS   OFF

Main State

BBER 000[%] TxRx Date: 2012/02/02 20:30 (UTC)

C/N   32[dB]  Tx Power Supply   

Rx AGC Level 200   Current Level 

REF Offset Freq   0[Hz]  Rx Power Supply 7.7[V]

Synthe Local  OK / OK   Current Level 30

TXCO Control 196 / 100

(1)

(2)

(3)(4)

(5)

(6)

(7)

(8)

*xx=Version no.



8.  MAINTENANCE AND TROUBLESHOOTING

8-3

8.3 Performance Verification (PV) Test

After the FELCOM is installed, the installer usually confirms that it is functioning prop-

erly, by logging in and conducting the PV test. This test consists of receiving a test 

message from an LES, transmitting a message to the LES and a distress alert test. 

The results of the test appear on the PV test result display.

The PV test cannot be conducted from an auxiliary terminal unit. Note that the test can 

also be initiated by an NCS.

8.3.1 PV test sequence

1. Select [PV Test] from the [Test] menu.

2. The MES requests an NCS to conduct the PV test.

3. The NCS acknowledges request for testing.

4. The MES, upon receiving acknowledgment from NCS, goes into pending state.

5. The NCS selects an LES to perform the test. 

6. The LES transmits a test message to the MES. 

7. The LES receives the test message.

8. The MES automatically transmits the distress alert test within two minutes after 

completion of step 7.

9.  When the distress alert test is finished, the LES sends the results of the PV test 

to the MES.

8.3.2 PV test procedure

1. Confirm that the communication unit is in idle condition and is logged in.

2. Press the F7, 8, and 1 keys to enable the PV test.

3. The [Start] window appears and [Yes] is selected; press the Enter key to start the 

test. The [PV Test] screen appears and shows the message "Starting PV Test 

Process. Press any key to escape."

Note: If the communication unit is not idle when the test is initiated, the screen dis-

plays "Ignored: MES is not idle now." If you are not logged in, "Ignored: MES is 

not Login. Please operate Login." appears.

4. Long-press the Esc key to return to the standby display.

5. The (automatic) testing sequence is as follows:

1)  The screen displays "Current State: Idle (pending!)" when you receive the ac-

knowledge signal from the NCS.

2) When preparations for testing have been completed, "Current State: TEST-

ING" appears at the bottom of the screen. Further, the message "Automatic 

test mode: Normal communication disabled. Do not press any distress button 

unless you are in distress." appears.

3) Receive a message from the LES. Send a test message to the LES. 

4) Then, the distress alert test is automatically conducted after you have sent a 

test message. Do not operate the equipment at this time. 

5) When testing has been completed, "Current State: IDLE" appears at the bot-

tom of the screen.
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8.3.3 How to show the PV test results

1. Press the F7, 8 and 2 keys to show the PV test results.

2. Long-press the Esc key to return to the standby display.

How to read the PV test results

Test Date & Time: Date and time of test

Attempts: Number of times the PV test was conducted.

BBER: Bulletin Board Error Rate (%). "Pass" appears for no error.

Shore-to-Ship Attempts: Number of tests initiated by LES.

Ship-to-Shore Attempts: Number of tests initiated by MES.

Distress Alert: "Pass (Test OK)" appears for successful testing.

Signal Strength: "Pass" appears if signal strength is greater than standard level.

Overall Result: "Pass" appears for satisfactory completion of the test. 

8.4 System Status Monitor

The system status monitor, which is always displayed, provides date, time, equipment 

status and navigation data.

Test Date & Time

Attempts

BBER

Shore-to-Ship Attempts

Ship-to Shore Attempts

Distress Alert

Signal Strength

Overall Result

02-02-25  01:58 (UTC)

First attempt

Pass

First attempt

First attempt

Pass (Test OK)

Pass (Greater than Std level + 10dB)

Pass (Applicable tests pass)

Ctrl+P: Print   ESC: Quit

PV Test Result

File     Edit     Transmit     EGC        Reports     Logs     Options     Setup                    StopAlarm

Date

Time

Position

Waypoint

Course 345.5 DEG 

Speed   10.2 kn

Current NCS

Current Channel

Current TDM

MES Status

GPS Status

DCE Memory

Jan-12-12

01:32 (UTC)

LAT   34:30.00N

LON 135:00.00E

LAT

LON

344 (IOR)   LOGOUT

NCS CC

NCS CC

Idle

****

32818 Bytes free

                                  IMN:

BBER

C/N

Send Level

Rx AGC Level

REF Offset Freq

Synthe Local             

TCXO Control                   131          

Antenna Power Supply

Water Temperature

Water Current

Direction

Speed

Depth

443156710

000

OK (    0 dB)

OK (    0)

OK (254)

OK (       0 Hz)

OK

OK

Current State: IDLE

DCE F19 Ver. xx

Retuning

NCS: IOR        LOGOUT              LAT:   34:30.00N

REC. MESSAGE EXISTS             LON: 135:00.00E

Jan-12-12  01:32 (UTC)

68.2 DEG

232  DEG

1.9   kn

xx: Program Version No. of COMMCPU Board
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How to read the system status monitor

Date: Current date.

Time: Current time.

Position: Own ship L/L position (either manual entry or automatic input by navigator). 

Waypoint: L/L position of destination waypoint set on navigator.

Course: Course.

Speed: Ship’s speed.

Current NCS: NCS your vessel is logged in with.

Current Channel: Channel in use.

Current TDM: Channel TDM.

MES Status: Operational status of MES.

GPS Status: Receiving signal status from GPS receiver.

   CST: Cold Start

   ACK: Acquired; Almanac data acquired.

   IMP: Impossible; cannot receive GPS signal.

   INT: Interrupted; object interfering with reception of GPS signal. 

   ALM: Receiving the almanac.

   2D, 3D: Position-fixing method by 2D or 3D.

DCE Memory: Memory remaining in communication unit.

BBER: Bulletin Board Error Rate (%).

C/N: Check of circuit status with LES, receiving circuit in antenna unit and COMMCPU 

Board in communication unit. OK appears for figure greater than 31.

Send Level: TX level check. At transmission, OK appears for figure greater than 100. 

At reception, OK appears for figure lower than 32.

RX AGC Level: Check of the receiving circuit of the antenna unit and the COMMCPU 

Board in the communication unit. OK appears for figure greater than 60.

REF Offset Freq: OK appears for figure lower than 150.

Synthe Local: Check of COMMCPU Board.

TCXO Control: Oscillator frequency control value.

Antenna Power Supply: NG appears for discontinuity or short in antenna cable. OK 

is shown if the antenna is receiving electrical power.

Water Temperature*: Water temperature.

Water Current*

   Direction: Tidal current direction.

   Speed: Tidal current speed.

Depth*: Depth of water.

* Requires data from appropriate sensor.
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8.5 Current Position Log

Position is saved to the [Current Position Log] every hour, and the log stores the latest 

100 positions. When the log becomes full, the eldest entry is automatically deleted and 

positions are renumbered.

To display the log, press the F7, 9 and 1 keys.

Current Position Log description

List: Put the highlight cursor here to put cursor in the list.

No.: The number of the position, in three digits.

Latitude, Longitude: Latitude and longitude of the position.

Op. Time(sec): The number of seconds the power has been on since the commission-

ing.

Date & Time(UTC): Date and time of the position.

Range: Specify the range of positions to show, with [From No.] and [To No.]. Put the 

cursor on [From No.] (or [To No.]) then press the Enter key. Enter no. then press the 

Enter key.

Total: Total no. of positions saved to the log.

[Ctrl]+[F]: Search: Search for specific position no.

[Ctrl]+[E]: Export: Export the position nos designated with [From No.] and [To No.], 

to the hard disk.

[Ctrl]+[P]: Print: Print the position nos designated with [From No.] and [To No.].

No. Latitude Longitude   Op. Time(sec)       Date & Time(UTC)

001 34:44.47N 135:21.29E   0000916673       JAN-21-12  17:46

002 35:21.29N 135:22.02E   0000913073       JAN-21-12  18:46

003    

004    

005    

006   

007  

008   

009   

010   

Current Position Log

Range:                                                                               Total: 2 

From No.           To No.

[Ctrl]+[F]: Search

[Ctrl]+[E]: Export      [Ctrl+[P]: Print

List
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8.6 How to Replace the Fuse

The 10A fuse (for 12 VDC) or 5A fuse (for 24 VDC) in the power cable for the commu-

nication unit protects the system from overcurrent and reverse polarity. If the fuse 

blows, find the cause before replacing it. If the fuse blows again after replacement, 

contact your dealer for advice.

8.7 Error Messages

This section describes the more commonly seen error messages and the means to 

restore normal operation. If normal operation cannot be restored, contact your dealer 

for advice. 

8.7.1 Equipment trouble messages

Messages in this category are prefixed with "TROUBLE".

WARNING
Use the proper fuse.

Use of a wrong fuse can result in fire or damage 

the equipment.

12 VDC

Type: FGBO 125V 10A PBF

Code No.: 000-155-826-10

24 VDC

Type: FGBO-A 125V 5A PBF

Code No.: 000-155-853-10

Error message Meaning Action

ANT power voltage abnor-

mality. 

Antenna power voltage is 

out of ratings. 

Have a licensed radio-

communications techni-

cian check the set. 

Carrier power level. Carrier power level too high 

or too low. 

Have a licensed radio-

communications techni-

cian check the set.

EEPROM ERROR.  EEPROM trouble. Contact a FURUNO agent 

or dealer for advice. 

Invalid MES ID. This equip-

ment is defected. Please 

contact FURUNO. 

MES ID is corrupted. Have a licensed radio-

communications techni-

cian check the set.

Synthesizer UNLOCK. Synthesizer unlock. Have a licensed radio-

communications techni-

cian check the set.
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8.7.2 Warning messages

Messages in this category are prefixed with "WARNING".

Error message Meaning Action

BBER over 80%. Scanning 
NCS start manually. 

BBER (Bulletin Board Error 
Rate) exceeded 80%. 

Select NCS manually. 

Cannot enter new DNID. 
Memory full for DNIDs.

Memory for DNIDs is full. Delete unnecessary DNIDs 
to enter new ones.

Cannot enter new ENID. 
Memory full for ENIDs. 

Memory for ENIDs is full. Delete unnecessary ENIDs 
to enter new ones.

Cannot find NCS CC in all 
region. Scanning is contin-
ued. 

No NCS found in region. Scanning automatically 
continues.

Cannot find NCS CC in pre-
ferred region. Scanning all 
region is started.

NCS could not be found in 
region selected. Scanning 
started to find NCS. 

If NCS could not be found, 
contact you dealer for ad-
vice. 

Internal GPS UNIT failure. GPS signal could not be 
found. 

Internal GPS receiver may 
be damaged if this mes-
sage appears frequently. 
Contact your dealer for ad-
vice. 

Synchronization loss. 
Please change EGC chan-
nel. 

Your station is not synchro-
nized with selected EGC 
channel.

Change EGC channel.

Synchronization loss. 
Please check the current 
ocean region. 

Your station is not synchro-
nized with selected NCS.

Change NCS.
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F1: File

1. New

2. Open

3. Close

4. Save

5. Delete

6. Rename

7. Print 

8. Print Setting

9. MIME (Decode)

F2: Edit

1. Cut

2. Copy

3. Paste

4. Insert (With Citation)

5. Select All

6. Search or Replace

7. Goto Line

8. Time or Pos. Ins

9. Change Window

1. Search

2. Replace

1. Top of Text

2. End of Text

3. Goto Line

1. Time

2. Position

Search Word

Direction

Search Word

Replace Word

Direction

Query or ALL

Chooses line to go to.

Forward, Back

Forward, Back

Query, ALL
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Confirmation               ON, OFF

Send Delay                 00:00 - 23:59; 00:00

Delivery Delay            Immediate, Deferred

Code                           IA5, ITA2, DATA

F3: Transmit

1. Transmit Message

2. Cancel

3. Request Delivery Status

Priority

Message File

Station Name

Destination Type

Prefix Code (Prefix selected)

Country/Ocean Code

Destination

Modem Type

   (FAX, FAX prefixed selected) 

Address (E-mail, SMS)

Subject (For e-mail)

Attach File (For e-mail)

LED ID

Option

Normal, Distress

Select Message

Select Message

T30 FAX

V21 V.21 300bps Duplex

V22 V.22 1200bps Duplex

V22B V.22bis 2400bps Duplex

V23 V.23 600/1200bps

V26B V.26bis 2400/1200bps

V26T V.26ter 2400bps Duplex

V27T V.27ter 4800bps/2400bps

V32 V.32 9600bps Duplex

Other

TELEX/MES

FAX

E-Mail

SMS

PSDN

X400

DNID

Special

TELEX/MES (Prefixed)

FAX (Prefixed)

PSDN (Prefixed)

X400 (Prefixed)

DNID (Prefixed)

Special (Prefixed)

F4: EGC

1. Display EGC Message

2. EGC Network ID

TRANSMIT
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F5: Reports

1. Data Report

2. Message 

    Report

1. Data Report 1

2. Data Report 2

3. Data Report 3

4. Data Report 4

1. Message Report 1

Status

Report Length

Destination

Activation

   Interval Time 

    (Regular Interval chosen)

    Report Times

    Start Time 1 (Daily chosen)

    Start Time 2 (Daily chosen)

    Start Time 3 (Daily chosen)

    Start Time 4 (Daily chosen)

Same as Data Report 1

Same as Data Report 1

Same as Data Report 1

PIN Code

Status

Station Name

Destination Type

    Prefix Code (Prefix chosen)

    Country/Ocean Code

    Destination

    Modem Type

     (FAX, FAX Prefixed chosen) 

    Address

     (E-Mail, SMS chosen)

    Subject (E-Mail chosen)

OFF

ON: Enhanced Data Report

ON: Usual Data Report

Position Only

Position and Course/Speed

Position and Course/Speed 

with SEA INF

DNID, LES ID, Member No.

Regular Interval, Daily

00:10-99:59; 00:10

1-999; 1, - - - (No Limit)

00:00-23:59

00:00-23:59

00:00-23:59

00:00-23:59

TELEX/MES

FAX

E-Mail

SMS

PSDN

X400

DNID

Special

TELEX/MES (Prefixed)

FAX (Prefixed)

PSDN (Prefixed)

X400 (Prefixed)

DNID (Prefixed)

Special (Pefixed)

T30 FAX

V21 V.21 300bps Duplex

V22 V.22 1200bps Duplex

V22B V.22bis 2400bps Duplex

V23 V.23 600/1200bps

V26B V.26bis 2400/1200bps

V26T V.26ter 2400bps Duplex

V27T V.27ter 4800/2400bps

V32 V.32 9600bps Duplex

Other

Max. 8

ON, OFF

Subscriber selection
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3. Enhanced Pre-Assigned Data Report (EPADR)

4. Data Network ID

2. Message Report 2

3. Message Report 3

4. Message Report 4

LES ID

Activation

    Interval Time

     (Regular Interval chosen)

    Report Times

    Start Time 1 (Daily chosen)

    Start Time 2 (Daily chosen)

    Start Time 3 (Daily chosen)

    Start Time 4 (Daily chosen)

Report Contents

    File (File chosen)

Same as Message Report 1

Same as Message Report 1

Same as Message Report 1

LES selection

Regular Interval, Daily

00:10 - 99:59; 00:10

1 - 999; 1, - - - (No Limit)

00:00 - 23:59

00:00 - 23:59

00:00 - 23:59

00:00 - 23:59

NAV, NAV+SEA INF, 

NAV (R), FILE

File selection

F6: Logs

1. Sent Messages

2. Received Messages

3. EGC Messages

4. Communication Log

F7: Options (FELCOM functions as Inmarsat MES)

1. Position

2. Login

3. Logout

4. Abort

5. Select NCS

6. Ocean Region

7. LES Information

8. Test

9. Maintenance         1. Current Position Log

Yes, No

Yes, No

Yes, No

Auto, West-Atlantic, East-Atlantic, Pacific, Indian

1. PV Test

2. PV Test Result

3. Diagnostic Test

4. SSAS Alert Button Test

Yes, No

Yes, No

Yes, No

F7: Options (FELCOM functions as EGC receiver)

1. Position

2. Login

3. Logout

4. Abort

5. Select EGC Ch.

6. Ocean Region

7. LES Information

8. Test

9. Maintenance         1. Current Position Log

Yes, No

Yes, No

Yes, No

Auto, West-Atlantic, East-Atlantic, Pacific, Indian

1. PV Test

2. PV Test Result

3. Diagnostic Test

4. SSAS Alert Button Test

Yes, No

Yes, No

Yes, No
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1. System Setup 

2. Editor Setup

3. Terminal Setup

System Date & Time

IMN

MES Operation Mode

Nav Port*

LAN Port*

Message Output Port*

EGC Output Port*

Network Setup*

Command Window

(For service technicians.)

Text Mode

Edit Mode

Word Wrap

Line No.

Tab Width

Column Width

Cursor Type

Scroll

Connection (Displays equipment connected to LAN.)

Detail (Select NIC at PC side.)

Date Disp. Form

Screen Saver

Window Color

Date input

IMN input

INMARSAT-C, EGC

Telex, Ascii

Insert, Overwrite

ON, OFF

ON, OFF

2 Char, 4 Char, 8 Char

Telex (fixed at 69 characters), Ascii (40-80,69)

Block, Underline

Full Screen, Half Screen)

F8: Setup

* No use.

YY-MM-DD, MMM-DD-YY, DD-MMM-YY

ON, OFF

Select Preset (1, 2, 3)

Load Default

Edit Color RCV Message Display,

EGC Message Display,

EDIT 1, EDIT 2,

Function, SUB Menu 1,

SUB Menu 2,

SUB Menu 3,

SUB Menu 4,

Message,

Base Window

L-WHITE*1, YELLOW,

L-MAGENTA, L-RED,

L-CYAN, L-GREEN,

L-BLUE, GRAY,

WHITE, BROWN,

MAGENTA, RED,

CYAN, GREEN, 

BLUE*2, BLACK

Window

Fore Color

Back Color

*1 Fore Color
*2 Back Color
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4. EGC Setup

5. Auto Mode 

    Setup

6. E-mail Setup

7. Directories

Additional Position

Navarea

Fixed Area

Waypoint* 

Station Code

Type of Message

    Ice reports

    Meteo. forecasts

    Pilot service

    LORAN messages

    SATNAV messages

    Other navaid msg

    QRU (no message)

Auto Communication Log Print

Receive Alarm

Auto Receive Message Save

Auto Receive Message Print

Data Report & Polling Print

Auto EGC Message Save

Auto EGC Message Print

LES Settings

Message Directory

EGC Message Directory

1 position

9 areas max.

A-Z

ON, OFF

ON, OFF

ON, OFF

ON, OFF

ON, OFF

ON, OFF

ON, OFF

ON, OFF

ON, OFF

ON, OFF

OFF, ON

OFF, ON

System

FleetNET

SafetyNET 

(Safety)

SafetyNET 

(Urgent&Distress)

System

FleetNET

SafetyNET 

(Safety)

ON, OFF

ON, OFF

ON, OFF

ON, OFF

ON, OFF

ON, OFF

ON, OFF

* Not used
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Max. 5 characters

Max. 15 characters

TELEX/MES

FAX

E-Mail

SMS

PSDN

X400

DNID

Special

TELEX/MES (Prefixed)

FAX (Prefixed)

PSDN (Prefixed)

X400 (Prefixed)

DNID (Prefixed)

Special (Prefixed)

T30 FAX

V21 V.21 300bps Duplex

V22 V.22 1200bps Duplex

V22B V.22bis 2400bps Duplex

V23 V.23 600/1200bps

V26B V.26bis 2400/1200bps

V26T V.26ter 2400bps Duplex

V27T V.27ter 4800/2400bps

V32 V.32 9600bps Duplex

Other

Max. 20 characters

Max. 15 characters

Max. 20 characters

Max. 19 characters

Max. 9 characters

Max. 4 characters

3 digits

3 digits

3 digits

3 digits

Max. 9 characters

Max. 9 characters

Max. 9 characters

Max. 9 characters

Max. 4 characters

OFF, ON (BASE64),

ON (UUENCODE)

Station Group

Station Name

Destination Type

Prefix Code

(Prefix chosen)

Country Code

Station ID

Modem Type 

(FAX, FAX Prefixed

chosen)

E-Mail Address

(E-Mail chosen)

Remarks

Name

Remarks

Service LES Name

Service ID (E-mail)

Service ID (SMS)

LES ID (AORW)

LES ID (AORE)

LES ID (POR)

LES ID (IOR)

To:

Cc:

Subject:

Separator:

SMS

Attach File (MIME)

1. Station List

(Max. 99 stations)

2. LES List

   (44 per ocean

   region)

3. EGC Channel List (20 per ocean region)

4. NCS Channel List (20 per ocean region)

5. E-Mail/SMS 

    Service List

   (16 max.)

8. Configuration
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6. Export/Import               Export                          

      

                                        

                                        Import

F9: No use

F10: Stop Alarm

1. Sent Message

2. Received Message

3. EGC Message

4. Station List

5. LES List

6. E-Mail/SMS Service List

7. Test

8. Maintenance

9. Settings

1. Station List

2. LES List

3. E-Mail/SMS Service List

4. Settings
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APPENDIX 2 MESSAGES

Below are the various operational messages and their meanings. Messages are arranged accord-

ing to function key.

Confirmation message

These messages appear in the confirmation window.

1. "Save this message?"

You are asked if you want to save a message.

2. "File already exists. Overwrite?"

You are asked if you are sure to overwrite file name entered.

3. "OK to delete file?"

You are asked if it is OK to delete selected file.

4. "Start"

Start a process.

5. "Decode"

Start decoding (a message).

6. "Search Start?"

Start search (for text).

7. "Replace Start?"

Start replacing (text)

8. "Cancel"

Cancel a process.

9. "Update"

Update a setting.

10."OK to Export?"

Start exporting (data).

11."OK to Import?"

Start importing (data).

12. "Connect"

Connect FELCOM

13. "Different network address. Show available network settings."

Show available IP addresses (to connect FELCOM).

F1: File

1. "Can’t delete."

Cannot delete selected file.

2. "Now saving"

File is being saved.

3. "Enter new file name"

Enter new file name.

4. "Can't rename."

Cannot rename selected file.

5. "Press any key to escape."

Press any key to erase displayed screen.)

NoYes

Confirmation

window
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8. "Checking" 

Checking MIME.

9. "Now decoding..." 

10. "Completed."

Save/MIME completed.

11. "Decode failed."

MIME decoding failed.

12. "This terminal does not support this code."

You attempted to decode a file not supported by the terminal.

13. "Decoded % file(s)."

Decoding MIME-coded file.

14. "This file is not encoding."

You selected a file that has not been coded.

15. "Directory not found."

You specified a folder that does not exist.

F3: Transmit

1. "Input Error: Message File."

Invalid message selected for transmission.

2. "Input Error: Country/Ocean Code."

Invalid country/ocean code entered.

3. "Input Error: Destination."

Invalid station ID entered.

4. "Input Error: Modem Type." 

Invalid mode type entered. (For FAX, select T30.)

5. "Input Error: E-Mail Address."

Invalid e-mail address entered.

6. "Input Error: LES ID."

Invalid LES ID entered.

7. "Input Error: Send Delay."

Invalid send delay time entered.

8. "Input Error: Prefix Code."

Invalid prefix code entered.

9. "Invalid character detected in message."

Invalid character found in TX message.

10. "Don't support E-Mail service in this NCS."

Selected NCS does not handle e-mail.

11. "Input Error: Too many stations."

You have selected too many stations to transmit to.

12. "Message file is too large (but enable to send)."

The size of the file you want to send is larger than 32,000 bytes. (The file can be sent, but only the 

first 32,000 bytes of information will be received.)

13. "Attach file is too large."

The size of the attachment you want to send is larger than 32,000 bytes.

14. "Attach file (file name) is not found." 

Cannot find attached file.

15. "Message is entered in sending Queue. Press any key."

TX message entered into queue.

16. "Can't enter this message to sending Queue. Press any key."

Could not enter TX message into queue. 
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F5: Data report

1. "Input Error: Country/Ocean Code."

Invalid country/ocean code entered.

2. "Input Error: Destination."

Invalid station ID entered.

3. "Input Error: LES ID."

Invalid LES ID entered.

4. "Input Error: Interval Time"

Invalid interval time entered.

5. "Input Error: Start Time"

Invalid start time entered.

6. "Input Error: Modem Type"

Invalid modem type entered.

7. "Input Error: Report Contents"

Invalid report contents entered.

8. "Input Error: Report Times"

Invalid number of report times entered.

9. "Input Error: Destination"

Invalid destination entered.

10. "Input Error: E-Mail Address"

Invalid e-mail address entered.

11. "Don't support E-Mail service in this NCS."

NCS does not handle e-mail.

12. "Input Error: Prefix Code"

Invalid prefix code entered.

F7: Option

Login

1. "Successful Login".

Login completed successfully.

2. "Login failed".

Login failed.

3. "Login aborted."

Login aborted.

4. "MES Signaling Failure, Login Request not sent to NCS."

MES signaling failure, login request not completed.

5. "Timeout! Login Acknowledgement not received."

Login acknowledgement not received.

6. "Login failed because of RESTORATION mode Network."

You attempted to login when the restoration mode is active.

Logout

1. "Successful Logout".

Logout completed successfully.

2. "Logout failed".

Logout failed.

3. "Logout aborted."

Logout aborted.

4. "MES Signaling Failure, Logout Request not sent to NCS."

MES signaling failure, logout request not completed.
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5. "Timeout! Logout Acknowledgement not received."

Logout acknowledgement not received.

6. "Logout failed because of RESTORATION mode Network."

You attempted to logout when the restoration mode is active.
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Abbreviation Meaning

ACQ Acquire

AGC Automatic Gain Control

Ant Antenna

AOR-E Atlantic Ocean Region-East

AOR-W Atlantic Ocean Region-West

AORE Same as AOR-E

AORW Same as AOR-W

Ascii American Standard Code for Information Interchange

ASCII Same as Ascii

AUS Australia

BBER Bulletin Board Error Rate

bps bits per second

C/N Carrier to Noise ratio

Cate Category

CC Common Channel

Ch. Channel

Char. Character

Col. Column

COM Communication

Ctrl Control

dB Decibel

DCE Data Communication Equipment

DEG Degree

DEL Delete

DHCP Dynamic Host Configuration Protocol

Dir Directory

DND, DNID Data Network Identity Number

DR Data Report

DTE Data Terminal Equipment

EDR Enhanced Data Rate

EEPROM Electrically Erasable Programmable Read-Only Memory
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EGC Enhanced Group Call

EML E-mail

END, ENID EGC Network Identity Number

EPADR Enhanced Pre-Assigned Data Report

ESC Escape

Eth Ethernet

EUR Euro (currency)

EXT External

FAX Facsimile (receiver)

Freq Frequency

GMDSS Global Maritime Distress Safety System

GPS Global Positioning System

Hz Hertz

IA5 International Alphabet No. 5

ID Identification

IMN Inmarsat Maritime Number

IMO International Maritime Organization

INF Information

INT Internal

IOR Indian Ocean Region

IP Internet Protocol

ITA2 International Telegraph Alphabet No. 2

KDDI Kokusai Denshin Denwa International

kn Knot, Knots

L Left

L-BLUE Light BLUE

L-CYAN Light CYAN

L-GREEN Light GREEN

L-MAGENTA Light MAGENTA

L-WHITE Light WHITE

LAN Local Area Network

LAT Latitude

LED Light Emitting Diode

LES Land Earth Station

Abbreviation Meaning
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LON Longitude

LRIT Long Range Identification and Tracking

MES Mobile Earth Station

Meteo. Meteorological

MIME Multipurpose Internet Mail Extensions

Msg Message

NAV Navigation

NCS Network Coordination Station

NED Netherlands

NG No Good

No. Number

NOR Norway

OCC Operation Control Center

Op. Operation

PADR Pre-Assigned Data Report

PIN Personal Identification Number

POR Pacific Ocean Region

PSD, PSDN Public Switched Data Network

PV Performance Verification

R Right, Receive

RAM Random Access Memory

RCV Received

REC. Receive, Received

REF Reference

ROM Read-Only Memory

Rx Receive

S South, Send

S.S. Space Systems

SCC Satellite Control Center

SD Secure Digital (card)

sec second

Seq. Sequential

Sig. Signal, Signalling

SMS Short Message Service

Abbreviation Meaning
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SMTP Simple Mail Transfer Protocol

SSAS Ship Security Alert System

St Status

Sync Synchronize, Synchronized

Synthe Synthesizer

Sz Size

T30FAX T.30 Fax

TCXO Temperature Compensated Crystal Oscillator

TDM Time Division Multiplexing

TERM Terminal

TLX Telex

Tx Transmit (send)

UNSYNC Unsynchronized

UTC Universal Time Coordinate

UUENCODE Unix-to-Unix encode

V. Version

Abbreviation Meaning
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International Telex/Telephone Country Code List

Area and Country Remarks for Telex Code
Telephone 

Country Code
Telex Country 

Code

Afghanistan

Alaska

Albania

Algeria

American Samoa

American Virgin Is.

Andorra

Angola

Anguilla

Antigua & Barbuda

Argentina

Armenia

Aruba

Ascension

Australia

Australian External 

Territories

Austria

Azerbaijani

Azores Is.

Bahamas

Bahrain

Bangladesh

Barbados

Belarus

Belgium

Belize

Benin

Bermuda

Bhutan

Bolivia (Rep. of)

Bolivia (ENTAL)

Bosnia-Hercegovina

Botswana

Brazil

British Virgin Is.

Brunei Darussalam

Bulgaria

Burkina Faso

Burundi

Telex calls to former WUI subscribers, insert the figure 

"9" after the destination code "208".

Disregard the figure "0" at head of subscriber number.

Subscriber numbers are 2XXX or 5XXX

Manual calls 3XXX

Destination code is the same as for Portugal.

Disregard the figure "0" at head of subscriber number.

93

1

355

21

684

1

33

244

1

2

54

7

297

247

61

672

43

994

351

1

973

880

1

7

32

501

229

1

975

591

387

267

55

1

673

359

226

257

79

200

604

408

770

208

590

991

391

393

33

684

303

939

71

766

47

784

404

297

490

780

392

681

46

371

972

290

890

371

309

600

962

38

292

809

67

978

903
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Area and Country Remarks for Telex Code
Telephone

Country Code 
Telex Country

Code 

Cambodia

Cameroon

Canada

Canary Is.

Cape Verde

Cayman Is.

Central Africa Rep.

Chad

Chile

China

Christmas Is. (Aus)

CIS (formerly USSR)

Cocos-Keeling Is.

Colombia

Comoros

Congo

Cook Is.

Costa Rica

Cote d'lvoire

Croatia

Cuba

Cyprus

Czechoslovakia

Denmark

Diego Garcia

Djibouti

Dominica

Dominican Rep.

Ecuador

Egypt

El Salvador

Estonia 

(formerly USSR)

Ethiopia

Kampuchea Rep.

Disregard the figure "0" at head of subscriber number.

Destination code is the same as for Spain.

TCH subscribers 2XXXXX 

ENTEL subscribers 5XXXXX

TRA subscribers 3XXXXX 

TECOM subscribers 6XXXXX

VTR CM subscribers 

4XXXXX

Disregard the figure "0" at head of subscriber number.

Manual calls 

Ivory Coast

RCA subscribers 4XXXXX

For subscriber number beginning with 346, disregard 

"346" at head of subscriber number.

AGEM IR subscribers 61XX

855

237

1

34

238

1

236

235

56

86

672

7

672

57

269

242

682

506

225

385

53

357

42

45

246

253

1

1

593

20

503

372

251

807

970

21

26

52

993

293

971

976

34

85

766

64

766

35

994

981

772

376

983

599

28

605

66

55

938

979

394

201

202

241

308

91

373

537

980
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Area and Country Remarks for Telex Code
Telephone 

Country Code
Telex Country 

Code

Falkland Is. (Malvinas)

Faroe Is.

Fiji

Finland

France

French Guiana

French Polynesia

Gabon

Gambia

Georgia

Germany (Fed, Rep. of)

Ghana

Gibraltar

Greece

Greenland

Grenada

Guadeloupe

Guam (RCA)

Guatemala

Guiana

Guinea Conakry

Guinea Bissau

Guyana

Haiti

Hawaii

Honduras

Hong Kong

Hungary

Iceland

India

Indonesia

Iran

Iraq

Ireland

Israel

Italy

Manual calls

RCA subscribers 9XXX

RCA subscribers 8XXX or 2968XX

ITT subscribers 743XXX

WUI subscribers 63XXX or 63XXXX

WUH subscribers 39XXXX

Telex calls to HTC subscribers can be made using 

Semi-automatic calls.

Disregard the figure "0" at head of subscriber number.

Disregard the figure "0" at head of subscriber number.

500

298

679

358

33

594

689

241

220

7

49

49

233

350

30

299

1

590

671

502

594

224

245

592

509

1

504

852

36

354

91

62

98

964

353

972

39

306

502

701

57

42

300

702

973

996

683

69

41

94

405

601

503

395

299

700

372

300

995

969

295

203

704

705

708

709

(773)

374

802

61

501

81

73

88

491

500

606

43



APPENDIX 4 INTERNATIONAL TELEX/TEL. COUNTRY CODE LIST, LES LIST

AP-20

Area and Country Remarks for Telex Code
Telephone 

Country Code
Telex Country 

Code

Jamaica

Japan

Jordan

Kazakhstan

Kenya

Kiribati

Korea (Demo, People's 

Rep. of)

Korea (Rep. of)

Kuwait

Kyrgyzstan

Lao

Latvia (formerly USSR)

Lebanon

Lesotho

Liberia

Libya

Liechtenstein

Lithunia 

(formerly USSR)

Luxembourg

Macao

Macedonia

Madagascar

Madeira Is.

Malawi

Malaysia

Maldives Is.

Mali

Malta

Mariana Is.

Marshall Is.

Maritinique

Mauritania

Mauritius

Mexico

Micronesia

Moldova

Monaco

Mongolia

KDDI (for 5 digits)

NTT

Subscriber numbers are 770XX

Subscriber number beginning with 4, 5, 7, 8 and 9 can 

be reached by Manual Calls.

Destination code is the same as for Portugal.

Subscriber number beginning with 11XX can be 

reached by Semi-automatic calls.

Disregard the figure "0" at head of subscriber number.

Destination code is the same as for France.

1

81

962

7

254

686

850

82

965

7

856

371

961

266

231

21

41

370

352

853

389

261

351

265

60

960

223

356

671

692

596

222

230

52

691

373

33

976

291

72

493

785

987

761

(899)

801

496

788

804

538

494

963

997

901

45

539

402

808

597

986

404

904

84

896

985

406

403

760

765

298

974

966

22

764

682

42

800
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Area and Country Remarks for Telex Code
Telephone 

Country Code
Telex Country 

Code

Montserrat

Morocco

Mozambique

Myanmar 

(formerly Burma)

Namibia

Nauru

Nepal

Netherlands

Netherlands Antilles

New Caledonia

New Zealand

Nicaragua

Niger

Nigeria

Niue Is.

Northern Mariana Is.

Norfolk Is.

Norway

Oman

Pakistan

Palau

Panama

Papua New Guinea

Paraguay

Peru

Philippines

Poland

Portugal

Puerto Rico

Qatar

2XXXX other numbers are for Semi-automatic calls.

TRT subscribers

AACR subscribers

INTEL subscribers

PHILCOM subscribers 2XXXX

RCPI subscribers 7XXXX

GMCR subscribers 4XXXX

ETPI subscribers 6XXXX

CAPWIRE subscribers 1XXXX

For PTT subscribers, insert the figure "8" after the 

destination code "75".

Disregard the figure "0" at head of subscriber number.

RCA subscribers 2XXX

ITT subscribers 345XXX

C&W, WUI subscribers

ACPR (PRCA) subscribers

1

21

258

95

264

674

977

31

599

687

64

505

227

234

683

670

672

47

968

92

680

507

675

595

51

63

48

351

1

974

396

407

992

83

908

775

891

44

390

706

74

375

975

905

776

766

56

498

82

763

377

378

379

703

305

36

75

63

404

205

206

207

209

497
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Area and Country Remarks for Telex Code
Telephone 

Country Code
Telex Country 

Code

Reunion

Romania

Russian Federation

Rwanda

Saipan

San Marino

Sao Tome & Principe

Saudi Arabia

Senegal

Seychelles

Sierra Leone

Singapore

Slovak

Slovenia

Solomon Is.

Somalia

South Africa

Spain

Spanish North Africa

Sri Lanka

St. Helena

St. Kitts & Nevis

St. Lucia

St. Pierre & Miquelon

St. Vincent & 

the Grenadines

Sudan

Suriname

Swaziland

Sweden

Switzerland

Syria

Tajikistan

Taiwan

Tanzania

Thailand

Togo

Tokelau

Tonga

Trinidad & Tobago

Tunisia

Turkey

Turkmenistan

Subscriber numbers are 916XXX

Disregard the figure "0" at head of 

subscriber number.

Manual calls

Cape Town subscribers XXXXXX

Bophuthatswana subscribers 08XXXX

Transkei subscribers 09XXX

Manual calls 4XXX

262

40

7

250

670

378

239

966

221

248

232

65

42

386

677

252

27

34

34

94

290

1

1

508

1

249

597

268

46

41

963

7

886

255

66

228

690

676

296

21

90

7

961

65

64

909

760

505

967

495

906

965

998

87

66

598

778

900

95

52

52

803

(960)

397

398

204

399

984

304

964

54

45

492

787

769

989

86

977

762

777

294

409

607

789
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Area and Country Remarks for Telex Code
Telephone 

Country Code
Telex Country 

Code

Turks & Caicos Is.

Tuvalu

U. A. E.

Abu Dhabi

Ajman

Dubai

Fujairah

Ras Al Khaimah

Sharjah

Umm Al Qaiwain

Uganda

Ukraine

United Kingdom

United Arab Emirates

Upper Volta

Uruguay

Uzbekistan

U. S. A.

U. S. A. (Mainland)

U. S. S. R. (Former)

Vanuatu

Vatican

Venezuela

Viet Nam

Wallis & Futuna Is.

Western Samoa

Yemen (Rep. of)

Yugoslavia (Former)

2XXXX, 3XXXX, 5XXXX

695XX

4XXXX

8XXXX

9XXXX

68XXX

697XX

Same as "Burkina Faso".

CCI subscribers 7XXXXXX

ITT subscribers 4XXXXX, 4XXXXXX, 4XXXXXXXXX

RCA subscribers 2XXXXX

WUI subscribers 6XXXX, 6XXXXX, 6XXXXXX

TRT subscribers 1XXXXX, 1XXXXXXXXX

FTCC subscribers 8XXXX, 8XXXXX

GRPHNET subscribers 36XXXXX, 37XXXXX

For WUT subscribers, insert the figure "0" after the 

destination code "23".

Telex calls to TWX subscribers whose numbers do not 

contain "0" as the third figure of the 10 figure code can 

be made as Semi-automatic calls.

Russian Federation

Subscriber number beginning with 561XXX can be 

made using manual calls

Formerly Yemen (P. D. Rep. of)

Formerly Yemen (Arab Rep.)

1

688

971

256

7

44

971

226

598

7

1

7

678

379

58

84

681

685

969

967

296

774

893

988

680

51

893

978

32

786

23

23

25

640

771

504

31

805

707

779

806

895
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LES List

Area and Country Remarks for Telex Code
Telephone 

Country Code
Telex Country 

Code

Ocean Area Remarks
Telephone 

Ocean Region 
Access Code

Telex Ocean 
Region Access

Zaire

Zambia

Zanzibar

Zimbabwe

Telex calls to places other than Kinshasa Subscriber 

beginning with 2XXXX can be made as Semi-automatic 

calls.

243

260

259

263

982

902

990

907

AOR-W

AOR-E

POR

IOR

Atlantic Ocean-W

Atlantic Ocean-E

Pacific Ocean

Indian Ocean

874

871

872

873

584

581

582

583

Land earth station operator      Country          AOR-E   AOR-W     IOR         POR

Beijing MCN China   311 211

Bezeq Israel 127  327

Vizada France 121 021 321 221

KDDI Japan 103 003 303 203

Morsviazsputnik Russia 117  317 217

OTE Greece 120  305

Embratel Brazil 114

Singapore Telecom Singapore   328 210

Stratos Global (Burum LES) Netherlands 112 012 312 212

Stratos Global (Burum-2 LES) Netherlands 102 002 302 

Stratos Global (Auckland LES) New Zealand    202

Telecom Italia Italy 105  335

Telekomunikacja Polska Poland 116  316

Vizada Norway 104 004 304 204

Vizada USA 101 001 301 201

VISHIPEL Vietnam   330

VSNL India   306
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TELEGRAPHY ALPHABET

International Telex Abbreviations

Abbreviation Meaning

ADV

ACK

AGN

BI(GS)

BK

CFN

COL

CRV

DER

DWN

EEE

FM

GA

MNS

MOM

MUTI

NA

NC

NCH

NP

NR

OCC

OK

P(or O)

PLS(PSE)

PPR

P(RCD)

RAP

RD

RE

RPT

SRY

SVP

TAX

TEST MSG

THRU

TKS(TNX)

TLX

Advise

Acknowledge

Again

Good bye

I cut off.

Confirm

Collation

How do you receive?

Out of order

Down

Error

From

Go ahead

Minutes

Wait(Waiting)

Mutilated

Correspondence to this subscriber is not admitted.

No circuits

Subscriber’s number has been changed.

The called party is not or is no longer a subscriber.

Indicate your call number.

Subscriber is engaged.

Agreed

Stop your transmission.

Please

Paper

Received

I will call again

Read

Referring to

Repeat

Sorry

Please

What is the charge?

Please send a test message.

You are in communication with telex position.

Thanks

Telex
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International Telegraphy Alphabet

No.

1

2

3

4

5

6

7

8

9

10

11

12

13

14

15

16

FIGURES

?

:

3

8

BELL

(

)

.

,

9

0

LETTERS

A

B

C

D

E

F

G

H

I

J

K

L

M

N

O

P

No.

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

FIGURES

1

4

'

5

7

=

2

/

6

+

LETTERS

Q

R

S

T

U

V

W

X

Y

Z

CARRIAGE RETURN

LINE FEED

LETTERS

FIGURES

SPACE

BLANK

*

*

*

*

*

* = Cannot be entered.
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Digital Interface

Input sentences: BWC, BWR, DBT, DTM, GGA, GLL, GNS, GSA, MTW, RMA, RMB, RMC, 

VDO, VDR, VTG, WPL, ZDA

Output sentences: None

Data reception

Data is received in serial asynchronous form in accordance with the standard referenced in IEC 

61162-1 Ed.4 2010-11. The following parameters are used:

Baud rate: 38,400 bps (VDO). The baud rate of all other sentences is 4800 bps.

Data bits: 8 (D7 = 0), Parity: none, Stop bits: 1

Data Sentences

Input sentences

BWC: Bearing and distance to waypoint

D0    D1     D2    D3     D4     D5     D6    D7

Start
bit

Stop
bitData bits

$ **BWC,hhmmss.ss,llll.ll, a,IIIII.II,a,yyy.y,T, yyy.y,M,yyy.y,N,c--c,A,*hh<CR><LF>
                       1           2    3    4    5   6    7      8    9   10   11 12 13
1. UTC of observation (000000.00 - 240001.00)
2. Waypoint latitude (0.00000 - 9000.00000)
3. N/S
4. Waypoint longitude (0.00000 - 18000.00000)
5. E/W
6. Bearing, degrees true (0.00 - 360.00)
7. Unit, True
8. Bearing, degrees  (0.00 - 360.00)
9. Unit, Magnetic
10. Distance, nautical miles (0.000 - 10000)
11. Unit , N
12. Waypoint ID (Max. 13 characters)
13. Mode Indicator* (A=Autonomous  D=Differential  E= Estimated  M=Manual  S=Simulator)
* Ver. 3.0 only
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BWR: Bearing and distance to waypoint - rhumb line

DBT: Depth below transducer

DTM: Datum reference

$ **BWR,hhmmss.ss,llll.ll,a,IIIII.II,a,yyy.y,T,yyy.y,M,yyy.y,N,c--c,A,*hh<CR><LF>
                     1            2    3    4    5    6    7    8    9   10  11  12 13
1. UTC of observation (000000.00 - 240001.00)
2. Waypoint latitude (0.00000 - 9000.00000)
3. N/S
4. Waypoint longitude (0.00000 - 18000.00000)
5. E/W
6. Bearing, degrees true (0.00 - 360.00)
7. Unit, True
8. Bearing, degrees  (0.00 - 360.00)
9. Unit, Magnetic
10. Distance, nautical miles (0.000 - 10000)
11. Unit , N
12. Waypoint ID (Max. 13 characters)
13. Mode Indicator* (A=Autonomous  D=Differential  E= Estimated  M=Manual  S=Simulator)
* Ver. 3.0 only

$**DBT,xxxx.x,f,xxxx.x,M,xxxx.x,F,*hh<CR><LF>
                1     2    3      4    5      6
1. Water depth (0.00-99999.99)
2. Feet
3. Water depth (0.00-99999.99)
4. Meters
5. Water depth (0.00-99999.99)
6. Fathoms

$**DTM,ccc,a,x.x,a,x.x,a,x.x,ccc,*hh<CR><LF>
                1  2  3   4  5  6  7    8
 1. Local datum (W84=WGS84  W72=WGS72  S85=SGS85,  P90=PE90
 User defined=999, IHO datum code
2. Local datum subdivision code (NULL or one character)
3. Lat offset, min (-59.99999 - 59.59999)
4. N/S 
5. Lon offset, min (no use)
6. E/W 
7. Altitude offset, meters (no use)
8. Reference datum (W84=WGS84  W72=WGS72  S85=SGS85,  P90=PE90)
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GGA: Global positioning system fix data

GLL: Geographic position

GNS: GNSS fix data

$**GGA,hhmmss.ss,llll.lll,a,yyyyy.yyy,a,x,xx,x.x,x.x,M,x.x,M,x.x,xxxx,*hh<CR><LF>
                       1          2   3        4        5 6 7   8    9  10 11 12 13  14
1. UTC of position (no use)
2. Latitude (0.00000 - 9000.00000)
3. N/S
4. Longitude (0.00000 - 18000.00000)
5. E/W
6. GPS quality indicator (1 -8)
7. Number of satllite in use (00 -12)
8. Horizontal dilution of precision (0.00 - 999.99), No use
9. Antenna altitude above/below mean sealevel (-999.99 - 9999.99), No use
10. Unit, m, No use
11. Geoidal separation (-999.99 - 9999.99), No use
12. Unit, m, No use
13. Age of differential GPS data (0 - 99), Ver. 2.0, 3.0 only 
14. Differential reference station ID (0000-1023), Ver. 2.0, 3.0 only

$**GLL,llll.lll,a,yyyyy.yyy,a,hhmmss.ss,a,x,*hh<CR><LF>
              1    2        3        4        5         6  7      
1. Latitude (0.00000 - 9000.00000)
2. N/S
3. Longitude (0.00000 - 18000.00000)
4. E/W
5. UTC of position (no use), Ver 2.0, 3.0 only
6. Status (A=data valid  V=data invalid), Ver 2.0, 3.0 only
7. Mode indicator* (A=Autonomous  D=Differential  E=Estimated  M=Manual  S=Simulator)
* Ver. 3.0 only)

$**GNS,hhmmss.ss,llll.lll,a,IIIII.III,a,c--c,xx,x.x,x.x,x.x,x.x,x.x,a*hh<CR><LF>
                      1           2    3    4     5  6     7   8   9  10  11  12 13
1. UTC of position (no use)
2. Latitude  (0.00000 - 9000.00000)
3. N/S
4. Longitude (0.00000 - 18000.00000)
5. E/W
6. Mode indicator
    N=No fix  A=Autonomous  D=Differential  P=Precise  R=Real Time Kinematic
    F=Float RTK  E=Estimated Mode  M=Manual Input Mode  S=Simulator Mode
7. Total number of satellites in use (00 - 99), No use
8. HDOP (0.0 - 999.99), No use
9. Antenna altitude, meters (-999.99 - 9999.99), No use 
10. Geoidal separation (-999.99 - 9999.99), No use
11. Age of differential data (0 - 999), No use
12. Differential reference station ID (0000 - 1023), No use
13. Navigational status indicator. No use
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GSA: GNSS DOP and active satellites

MTW: Water temperature

RMA: Recommended minimum specific Loran-C data

$**GSA,a,x,xx,xx,xx,xx,xx,xx,xx,xx,xx,xx,xx,xx,x.x,x.x,x.x,a*hh<CR><LF>
            1 2                         3                              4    5    6   7 
1. Mode (M=manual, forced to operate in 2=2D  3=3D mode
             A=automatic, allowed to automatically switch 2D/3D)
2. Mode (1=fix not available  2=2D  3=3D)
3. ID number of satellites used in solution (01 - 96, NULL)
4. PDOP (0.00 - 999.99)
5. HDOP (0.00 - 999.99)
6. VDOP (0.00 - 999.99)
7. GNSS System ID

$**MTW,x.x,C*hh<CR><LF>

                1  2    
1. Water temperature (-9.999 - 99.999)
2. Degrees C

$**RMA,A,llll.ll,a,yyyyy.yy,a,x.x,x.x,x.x,x.x,x.x,a,a*hh <CR><LF>
                 1   2  3      4       5   6   7    8   9   10 1112
1. Status: A=data valid, V=blink, cycle or SNR warning
2. Latitude, degrees (0.0000 - 9000.0000)
3. N/S
4. Longitude, degrees (0.0000 - 18000.0000)
5. E/W
6. Time difference A, microseconds (0.0 - 99999.9), No use
7. Time difference B, microseconds (0.0 - 99999.9), No use
8. Speed over ground, knots (0.0 - 9999.9)
9. Course over ground, degrees true  (0.0 - 359.9)
10. Magnetic variation, degrees (0.0 - 180), No use
11. E/W
12. Mode indicator (A= Autonomous   D= Differential mode  E=Estimated (dead reckoning mode)    
      M=Manual input mode  S= Simulator  N=Data not valid) 
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RMB: Recommended minimum specific navigation data

RMC: Recommended minimum specific GNSS data

VDO: UAIS VHF data-link own-vessel report

$**RMB,A,x.x,L,CCCC,CCCC,xxxx.xx,a,xxxxxx.xx,a,xxx.x,xxx,xx.x,A,a*hh <CR><LF>    
              1  2  3     4          5           6     7        8       9    10    11  12 1314
1. Data status (A=data valid, V=navigation receiver warning)
2. Cross track error (NM) (0.00 - 9.99), No use
3. Direction to steer (L/R), No use
4. Origin waypoint ID, No use
5. Destination waypoint ID, No use
6. Destination waypoint latitude (0.0000 - 9000.000)
7. N/S
8. Destination waypoint longitude (0.0000 - 18000.000)
9. E/W
10. Range to destination, nautical miles (0.000 - 10000), No use 
11. Bearing to destination, degrees true (0.0 - 359.9), No use
12. Destination closing velocity, knots (-99.9 - 99.9), No use
13. Arrival status (A=Arrival circle entered or perpendicular passed, V=not entered/passed), No use
14. Mode indicator (A= Autonomous   D= Differential mode  E=Estimated (dead reckoning mode)    
      M=Manual input mode  S= Simulator  N=Data not valid)

$**RMC,hhmmss.ss,A,llll.ll,a,yyyyy.yy,a,x.x,x.x,ddmmyy,x.x,a,a,a*hh<CR><LF>
                           1    2   3   4       5       6  7   8        9       10 11 12 13 
1. UTC of position fix (000000 - 235959)
2. Status (A=data valid, V=navigation receiver warning)
3. Latitude (0.0000 - 9000.0000)
4. N/S
5.  Longitude (0.0000 - 18000.0000)
6. E/W
7. Speed over ground, knots (0.0 - 9999.9)
8. Course over ground, degrees true (0.0 - 359.0)
9. Date (010100 - 311299)
10. Magnetic variation, degrees E/W (0.0 - 180.0/NULL), No use
11. E/W
12. Mode indicator (A= Autonomous   D= Differential mode  E=Estimated (dead reckoning) mode)    
      M=Manual input mode  S= Simulator  N=Data not valid)
13. Navigational status indicator. No use

!**VDO,x,x,x,x,s--s,x,*hh<CR><LF>
             12 3 4  5   6
1. Total number of sentences needed to transfer the message (1 to 9)
2. Message sentence number (1 to 9)
3. Sequential message identifier (0 to 9, NULL)
4. AIS channel Number (A or B)
5. Encapsulated ITU-R M.1371 radio message (1 - 63 bytes)
6. Number of fill-bits (0 to 5)
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VDR: Set and drift

VTG: Course over ground and ground speed

WPL: Waypoint location

ZDA: Time and date

$**VDR,x.x,T,x.x,M,x.x,N,*hh <CR><LF>
              1   2  3   4  5   6
1. Direction, degrees (0.0 - 360.0)
2. T=True (fixed)
3. Direction, degrees (0.0 - 360.0)
4. M=Magnetic (fixed)
5. Current speed (0 - 99.99)
6. N=Knots (fixed)

$**VTG,x.x,T,x.x,M,x.x,N,x.x,K,a,*hh <CR><LF>
              1   2   3  4  5   6   7  8  9
1. Course over ground, degrees (0.0 - 359.9)
2. T=True (fixed)
3. Course over ground, degrees (0.0 - 359.9)
4. M=Magnetic (fixed)
5. Speed over ground, knots (0.00-9999.9)
6. N=Knots (fixed)
7. Speed over ground (0.00 - 9999.9)
8. K=km/h (fixed)
9. Mode indicator (A=Autonomous,  D=Differential  E = Estimated (dead reckoning)
 M=Manual input  S=Simulator  N=Data not valid)

$**WPL,llll.ll,a,yyyyy.yy,a,c--c*hh<CR><LF>
               1   2       3      4    5
1. Waypoint latitude (0.000000 - 9000.00000)
2. N/S
3. Waypoint longitude (0.00000 - 18000.00000
4. E/W
5. Waypoint identifier (No use)

$**ZDA,hhmmss.ss,xx,xx,xxxx,xx,xx<CR><LF>
                      1         2   3    4     5  6
1. UTC (000000.00 - 240001.00)
2. Day (01 - 31)
3. Month (01 -12)
4. Year (UTC, 0000 - 9999)
5. Local zone, hours (-13 to ±13), No use
6. Local zone, minutes (00 to ±59), No use
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1 GENERAL 

1.1 Transmitting frequency 1626.5 to 1646.5 MHz 

1.2 Receiving frequency 1537.0 to 1544.2 MHz 

1.3 Channel interval 5 kHz 

1.4 G/T Better than -23.7 dB/K (elevation angle 5°) 

1.5 EIRP 7 to 16 dBW (elevation angle 5°) 

1.6 Modulation BPSK 

1.7 Modulation rate 600/1200 sps 

1.8 Coding Convolution with coding rate 1/2 and constraint length 7 

1.9 Decoding Viterbi decoder 

1.10 Nav data interface IEC61162-1 Ed.3/4, Internal GPS Board 

Input data sentences BWC, BWR, DBT, DTM, GGA, GLL, GNS, GSA, MTW, RMA, RMB, 

 RMC, VDO, VDR, VTG, WPL, ZDA 

2 ANTENNA UNIT 

2.1 Antenna type Daisy loop antenna 

2.2 Receiving gain 33 to 40 dB 

2.3 Receiving NF 1.7 dB or less 

2.4 Transmitting gain 26 to 40 dB 

2.5 Polarization Right-hand circular polarization 

2.6 Axial ratio Within 6 dB (5° to 90°) 

2.7 VSWR 2.0 or less (50 ohm) 

3 POWER SOURCE 

3.1 Communication unit 12-24 VDC: 3.8-1.9 A (Transmitting), 0.8-0.4 A (Receiving) 

3.2 AC/DC power supply unit 

PR-240 (option) 100-115/200-230 VAC, 1 phase, 50/60 Hz, 24 VDC from battery 

4 ENVIRONMENTAL CONDITION 

4.1 Ambient temperature 

Exposed equipment -35°C to +55°C (storage: -35°C to +70°C) 

Protected equipment -15°C to +55°C 

4.2 Relative humidity 95% at 40°C 

4.3 Degree of protection 

Antenna unit IP56 

Communication unit IP22 (tabletop/bulkhead mount) 

Others IP22 (bulkhead mount) 

4.4 Vibration Inmarsat SDM LPSES standard 

5 UNIT COLOR 

5.1 Antenna unit Upper: N9.5, Lower: 2.5PB3.5/10 

5.2 Communication unit/Junction box N2.5 

5.3 Others 2.5GY5/1.5 
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